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Read This First

Welcome to the Thermo Scientific, LTQ Orbitrap Discovery™ system! 
The LTQ Orbitrap Discovery is a member of the family of LTQ™ mass 
spectrometer (MS) detectors.

About This Guide
This LTQ Orbitrap Discovery Getting Started manual provides you with 
information on how to set up, calibrate, and tune the LTQ Orbitrap 
Discovery. Procedures in Chapters 1–4 can be performed from the 
Xcalibur™ Tune Plus window.

Who Uses This Guide

This LTQ Orbitrap Discovery Getting Started manual is intended for all 
personnel that needs to operate the LTQ Orbitrap Discovery, especially 
the key operator. This manual should be kept near the instrument to be 
available for quick reference.

Scope of This Guide

LTQ Orbitrap Discovery Getting Started includes the following chapters:

• Chapter 1: “Introduction” provides general information about this 
manual. 

• Chapter 2: “Tune Plus Window” provides information on the Tune 
Plus window.

• Chapter 3: “Calibrating the Instrument for FTMS Measurements” 
provides procedures to calibrate your LTQ Orbitrap Discovery for 
FTmeasurements.

• Chapter 4: “Performing Diagnostics/Checks” describes several 
diagnostic procedures.

• Chapter 5: “Instrument Setup” describes the FT relevant topics of 
the data dependent settings in the Instrument Setup.

• Chapter 6: “Instrument Configuration” gives instructions about 
configuring your instrument.
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Read This First
About This Guide
• Chapter 7: “MALDI LTQ Orbitrap Series Instruments” describes 
the Orbitrap relevant differences in instrument settings and 
procedures with respect to using a MALDI ion source.

• Appendix A: “Miscellaneous Information” gives additional 
information about various topics.
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Read This First
Related Documentation
Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the 
following documents for LTQ Orbitrap Discovery:

• LTQ Orbitrap XL / LTQ Orbitrap Discovery Preinstallation 
Requirements Guide

• LTQ Orbitrap Discovery Hardware Manual

• MALDI Source Getting Started

• MALDI Source Hardware Manual

The software also provides Help.
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Read This First
Contacting Us
Contacting Us
There are several ways to contact Thermo Fisher Scientific. 

Assistance

For technical support and ordering information, visit us on the Web:

www.thermo.com/advancedms

Customer Information Service

cis.thermo-bremen.com is the Customer Information Service site aimed 
at providing instant access to 

• latest software updates

• manuals, application reports, and brochures.

Note Thermo Fisher Scientific recommends that you register with the 
site as early as possible. ▲

To register, visit register.thermo-bremen.com/form/cis and fill in the 
registration form. Once your registration has been finalized, you will 
receive confirmation by e-mail. 

Changes to the Manual

❖ To suggest changes to this manual

• Please send your comments (in German or English) to:

Editors, Technical Documentation
Thermo Fisher Scientific (Bremen) GmbH
Hanna-Kunath-Str. 11

28199 Bremen

Germany

• Send an e-mail message to the Technical Editor at

documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index.
Thank you.
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Read This First
Typographical Conventions
Typographical Conventions
This section describes typographical conventions that have been 
established for Thermo Fisher Scientific manuals.

Data Input

Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click on Close”.

Topic Headings

The following headings are used to show the organization of topics 
within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
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Safety and EMC Information
Safety and EMC Information
In accordance with our commitment to customer service and safety, 
these instruments have satisfied the requirements for the European CE 
Mark including the Low Voltage Directive.

Designed, processed, and tested in an ISO9001 registered facility, this 
instrument has been shipped to you from our manufacturing facility in a 
safe condition.

This instrument must be used as described in this manual. Any use of 
this instrument in a manner other than described here may result in 
instrument damage and/or operator injury.

Notice on Lifting and Handling of Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the 
physical handling of this Thermo Scientific instrument requires a team 
effort for lifting and/or moving the instrument. This instrument is too 
heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of Thermo Scientific Instruments

In compliance with international regulations: If this instrument is used 
in a manner not specified by Thermo Fisher Scientific, the protection 
provided by the instrument could be impaired.

Notice on the Susceptibility to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic 
environment. Do not use radio frequency transmitters, such as mobile 
phones, in close proximity to the instrument.

Safety and Special Notices

Make sure you follow the precautionary statements presented in this 
guide. The safety and other special notices appear different from the 
main flow of text. Safety and special notices include the following:

Caution Cautions highlight information necessary to protect your 
instrument from damage. ▲

Note Notes highlight information that can affect the quality of your 
data. In addition, notes often contain information that you might need 
if you are having trouble. ▲

Warning Warnings highlight hazards to human beings. Each Warning is 
accompanied by a Warning symbol. ▲
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Safety and EMC Information
Identifying Safety Information

The LTQ Orbitrap Discovery Getting Started contains precautionary 
statements that can prevent personal injury, instrument damage, and 
loss of data if properly followed. Warning symbols alert the user to check 
for hazardous conditions. These appear throughout the manual, where 
applicable. The most common warning symbols are:

In addition to the above described, every instrument has specific 
hazards. So, be sure to read and comply with the precautions described 
in the subsequent chapters of this guide. They will help ensure the safe, 
long-term use of your system.

General Safety Precautions

Observe the following safety precautions when you operate or perform 
service on your instrument:

• Before plugging in any of the instrument modules or turning on the 
power, always make sure that the voltage and fuses are set 
appropriately for your local line voltage.

Warning This general symbol indicates that a hazard is present that 
could result in injuries if it is not avoided. 
The source of danger is described in the accompanying text. ▲

Warning High Voltages capable of causing personal injury are used in 
the instrument. The instrument must be shut down and disconnected 
from line power before service is performed. Do not operate the 
instrument with the top cover off. Do not remove protective covers from 
PCBs. ▲

Warning Treat heated zones with respect. Parts of the instrument might 
be very hot and might cause severe burns if touched. Allow hot 
components to cool before servicing them. ▲

Warning Wear gloves when handling toxic, carcinogenic, mutagenic, or 
corrosive/irritant chemicals. Use approved containers and procedures for 
disposal of waste solution. ▲

Warning Laser Radiation Avoid eye or skin exposure to direct or 
scattered radiation! ▲
Thermo Fisher Scientific LTQ Orbitrap Discovery Getting Started vii



Read This First
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• Only use fuses of the type and current rating specified. Do not use 
repaired fuses and do not short-circuit the fuse holder.

• The supplied power cord must be inserted into a power outlet with a 
protective earth contact (ground). When using an extension cord, 
make sure that the cord also has an earth contact.

• Do not change the external or internal grounding connections.
Tampering with or disconnecting these connections could endanger 
you and/or damage the system.

• The instrument is properly grounded in accordance with regulations 
when shipped. You do not need to make any changes to the 
electrical connections or to the instrument’s chassis to ensure safe 
operation.

• Never run the system without the housing on. Permanent damage 
can occur.

• Do not turn the instrument on if you suspect that it has incurred 
any kind of electrical damage. Instead, disconnect the power cord 
and contact a service representative for a product evaluation. Do not 
attempt to use the instrument until it has been evaluated. (Electrical 
damage may have occurred if the system shows visible signs of 
damage, or has been transported under severe stress.)

• Damage can also result if the instrument is stored for prolonged 
periods under unfavorable conditions (e.g., subjected to heat, water, 
etc.).

• Always disconnect the power cord before attempting any type of 
maintenance.

• Capacitors inside the instrument may still be charged even if the 
instrument is turned off.

• Never try to repair or replace any component of the system that is 
not described in this manual without the assistance of your service 
representative.

• Shut Down the Laser Before You Perform any Service on the 
MALDI Source. The MALDI source uses a high-energy ultraviolet 
laser capable of causing personal injury. Do not operate the source 
with the cover off the sample module.

• Do not place any objects – especially not containers with liquids – 
upon the instrument. Leaking liquids might get into contact with 
electronic components and cause a short circuit.
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Safety Advice for Possible Contamination

Hazardous Material Might Contaminate Certain Parts of Your 
System During Analysis.

In order to protect our employees, we ask you to adhere to special 
precautions when returning parts for exchange or repair. 

If hazardous materials have contaminated mass spectrometer parts, 
Thermo Fisher Scientific can only accept these parts for repair if they 
have been properly decontaminated. Materials, which due to their 
structure and the applied concentration might be toxic or which in 
publications are reported to be toxic, are regarded as hazardous. 
Materials that will generate synergetic hazardous effects in combination 
with other present materials are also considered hazardous. 

Your signature on the Repair-Covering letter confirms that the 
returned parts have been decontaminated and are free of hazardous 
materials. 

The Repair-Covering letter can be ordered from your service engineer or 
downloaded from the Customer Information Service (CIS) site. Please 
register under http://register.thermo-bremen.com/form/cis.

Parts contaminated by radioisotopes are not subject to return to Thermo 
Fisher Scientific – either under warranty or the exchange part program. 
If parts of the system may be possibly contaminated by hazardous 
material, please make sure the Field engineer is informed before the 
engineer starts working on the system.
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Chapter 1 Introduction

This manual describes only the FTMS detector relevant settings and 
procedures of the LTQ Orbitrap Discovery software (Tune plus 
version 2.5.5). For ion trap relevant settings and procedures, refer to the 
LTQ XL Getting Started manual.

In addition to this manual, the LTQ Orbitrap Discovery Tune Plus 
Online Help gives information to specific topics. Nevertheless, it is 
recommended to read this manual entirely.
Thermo Fisher Scientific LTQ Orbitrap Discovery Getting Started 1-1





Chapter 2 Tune Plus Window

This chapter provides LTQ Orbitrap Discovery specific information 
about the Tune Plus window. It contains the following topics:

• “Preliminary Remarks” on page 2-2

• “View Menu” on page 2-3

• “Scan Mode Menu” on page 2-9

• “Display Menu” on page 2-16

• “Setup Menu” on page 2-17

• “Tune Methods” on page 2-22
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Tune Plus Window
Preliminary Remarks
Preliminary Remarks
The Tune Plus window shows the schematic view of the LTQ Orbitrap 
Discovery and the instrument name. See Figure 2-1. 

To access the functions of the Tune Plus window, use the menu 
commands, toolbar buttons, and display views. The FT relevant changes 
or additions of the menu commands, toolbar buttons, and display views 
are explained in the following chapters.

HCD Option

If the LTQ Orbitrap Discovery is equipped with the HCD option and 
the HCD option has been activated on the FT Settings page (See 
page 6-3.), the instrument icon on the Instrument Control toolbar 
shows the HCD collision octapole on the right side. See Figure 2-2.

Figure 2-1. Tune Plus window

Figure 2-2. Instrument schematics with HCD option

HCD collision cell
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Tune Plus Window
View Menu
View Menu
This section describes those elements of the View menu that are 
different from the LTQ XL™ version of the Tune Plus window.

Spectrum View

The Spectrum view displays real-time ion trap or FT mass spectra 
depending on the analyzer type selected in the Define Scan dialog box. 
See Figure 2-3.

The Spectrum view page has a shortcut menu, which is displayed when 
you right-click anywhere on the page. To open the Spectrum Display 
Options dialog box, choose Display Options. The dialog box has two 
pages: the Ion Trap page and the FT page.

Figure 2-3. Spectrum View page
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Tune Plus Window
View Menu
On the FT page, you can determine the number of decimals shown on 
peak labels. See Figure 2-4. To change the number of decimals, click on 
the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. You can set the number of decimals to any value from 
0 to 5. Alternatively, you can enter a value in the spin box text field. The 
LTQ Orbitrap Discovery changes the number of decimals when you 
click on Apply or OK.

 

A check box allows you to show additional analyzer information for 
FTMS scans. This information will be displayed above the spectrum 
graph if the box is selected. See topic “FT Analyzer Messages” on 
page A-3 for a list of items that may be displayed as analyzer 
information.

You can also decide whether or not to show the resolution and/or the 
charge state of peaks in the FT spectrum by clearing or selecting the 
corresponding check boxes.

If the FTMS analyzer is used, it is possible to display different diagnostic 
views in the Spectrum view. See Chapter 4: “Performing 
Diagnostics/Checks” for diagnostic features that involve the Spectrum 
view.

Figure 2-4. Spectrum Display Options dialog box – FT page
2-4 LTQ Orbitrap Discovery Getting Started Thermo Fisher Scientific



Tune Plus Window
View Menu
Graph View

The Graph view displays, in a variety of traces, real-time data generated 
during calibration, tuning, and diagnostic tests. For example, Figure 2-5 
shows the progress of the FT transfer multipole frequency calibration.

Status View

The Status view displays real-time status information for the 
LTQ Orbitrap Discovery. See Figure 2-6 on page 2-6. The Status view 
has two pages: the All page and the User page. The All page displays the 
real-time status information for about 80 parameters of the 
LTQ Orbitrap Discovery. You can scroll through the list to observe the 
status of the parameters. The User page displays real-time status 
information for LTQ Orbitrap Discovery parameters that you have 
selected in the User Status Display Configuration dialog box. (See 
page 2-7.)

Figure 2-5. Graph view page
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Figure 2-6. Status view page – All page
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User Status Display Configuration Dialog Box

Figure 2-7 shows the User Status Display Configuration dialog box.

❖ To configure the User page

1. Choose View > Display Status View.

2. Click on the User tab. Right-click on the User page to display the 
shortcut menu.

3. Choose Configure.

Figure 2-7. User Status Display Configuration dialog box
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This section describes the elements of the Control menu that are 
different from the LTQ XL.

Advanced Calibration Features

Use the Advanced Calibration Features command to display advanced 
features on the Semi-Automatic page of the Calibrate dialog box, such as 
storage transmission and the FT transmission (See Figure 3-7 on 
page 3-17.):

• If the command is displayed as “Advanced Calibration Features” this 
indicates that the command is disabled. Normal features will be 
displayed.

• If the command is displayed as “✓ Advanced Calibration Features” 
this indicates that the command is enabled. Advanced features will 
be displayed.

Activate/deactivate this command by choosing Control > Advanced 
Calibration Features.
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This section describes the elements of the Scan Mode menu that are 
different from the LTQ XL.

Define Scan

The Define Scan dialog box allows you to define a scan in various ways 
depending on the scan mode and scan type combination. Also, the 
Define Scan dialog box allows you to choose the ion trap or the 
Orbitrap™ analyzer (FTMS) as analyzer. Figure 2-8 shows the Define 
Scan dialog box showing the Advanced Scan features. The Advanced 
Scan features can be activated in the Scan Mode menu of Tune plus.

Figure 2-8. Define Scan dialog box (Advanced Scan Features enabled)
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Scan Description

The Scan Description group box contains the following elements:

Scan Time

The Scan Time group box contains the following elements:

Analyzer At the top, the Analyzer list box allows you to 
select the analyzer type used during the currently 
selected scan event. The options are as follows:

• FTMS selects the Orbitrap detector.

• Ion Trap selects the ion trap detector.
Mass Range The following mass ranges are available:

• Low: 15–200 for ion trap analyzer only

• Normal: 50–2000 for ion trap and FTMS 
analyzer

• High: 100–4000 for ion trap and FTMS 
analyzer

Scan Rate / 
Resolution

When you have selected the entry Ion Trap in 
the Analyzer list box, this list box allows you to 
set the scan rate (Normal, Enhanced, Turbo, 
Zoom, UltraZoom).

When you have selected the entry FTMS in the 
Analyzer list box, this list box allows you to set 
the resolution of the FT mass spectra. The mass 
resolution is selectable between several options. 
Available resolution settings are 7500, 15000, 
and 30000. 

Scan Type Usage of the scan types Full MS, SIM, SRM, or 
CRM is analogous to the ion trap. However, 
only one scan range is available for FTMS SIM, 
FTMS SRM, and FTMS CRM scans.

Microscans The number of microscans determines how 
many spectra are averaged in one analytical scan. 
If the FTMS is chosen as the analyzer, transients 
are averaged for one analytical scan.

The number of microscans can be set 
individually for FTMS, Ion Trap MS, FTMS 
SIM, Ion Trap SIM, FT MSn, Ion Trap MSn, and 
Ion Trap Zoom.
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Max Inject Time The inject time is automatically controlled by the 
automatic gain control (AGC). The entry in this 
spin box limits the inject time to a maximum 
value. To ensure the high mass accuracy of the 
LTQ Orbitrap Discovery, the maximum inject 
time should not be reached. Otherwise, the 
number of ions does not correspond to the 
AGC target value. 
The maximum inject time can be set individually 
for FTMS, Ion Trap MS, FTMS SIM, Ion Trap 
SIM, FT MSn, Ion Trap MSn, and Ion Trap 
Zoom.

Note If the maximum inject time is reached the 
number of ions may not correspond to the 
current AGC target value. This may affect the 
mass accuracy of FTMS spectra. ▲

Scan Time Settings Click on All to display the Scan Time Settings 
dialog box. See Figure 2-9. It allows displaying 
and setting all scan time settings for all scan types 
at the same time for both the ion trap and the 
FT analyzer.

Figure 2-9. Scan Time Settings dialog box – FT page
Thermo Fisher Scientific LTQ Orbitrap Discovery Getting Started 2-11



Tune Plus Window
Scan Mode Menu
Locking

The locking feature allows using one or more peaks in the spectrum as 
internal reference in order to improve mass accuracy. Locking is 
available for FTMS analyzer type.

Select the On check box in the Locking group box to enable the locking 
feature. Then, click on Masses to display a dialog box for entering and 
editing lock mass lists. See Figure 2-10.

Lock mass lists can consist of one or more lock masses. If the list 
contains lock masses that are (temporarily) not found in the spectrum, 
these lock masses are ignored (temporarily) and the instrument steps 
back to the external calibration. Thus, even when lock masses are used, 
the instrument should be external calibrated as well. For standard full 
scan experiments, it is expected that the spectrum shows at least one 
peak that corresponds to a lock mass.

There are two situations where the instrument makes use of a special 
mode to artificially mix the lock mass into the spectrum:

• If none of the given lock masses is found in the full spectrum, the 
instrument tries to improve the abundance of the lock mass by 
performing additional SIM injections of the specified lock mass. 

• If the given lock mass cannot be found in the spectrum because the 
instrument runs in MSn or SIM scan type, the instrument adds the 
lock mass by using SIM injections.

This way, lock masses can be used for all FTMS scan types and for 
varying lock mass abundances. There is no need for user interaction 
other than specifying a list of reference peak candidates.

Figure 2-10. Lock Masses dialog box
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See topic “FT Analyzer Messages” on page A-3 on how to view 
information about the instruments locking state. See topic “Using 
Locking in Automated Runs” on page 5-2 on how to set FTMS locking 
in Instrument Setup.

MSn Settings

The table in this group box allows you to specify the parameters for each 
segment of an MSn experiment. 

1Act. Type The Activation Type list box becomes available 
when you enter a parent mass. It allows you to 
specify how the ions are activated for 
fragmentation and has the following options:

• CID (Collision-induced dissociation)

• PQD (Pulsed-Q dissociation)

• HCD (higher energy CID)1

Use HCD to obtain triple quadrupole-like 
fragment ion spectra. HCD is available only as 
the last step in an MSn experiment – it is not 
possible to set up an experiment where the 
first activation method is HCD, and the 
second method is CID. If you enter a new step 
below an HCD experiment, the Tune Plus 
program will change it to a CID experiment.

Act. Q When HCD1 is selected in the Activation Type 
list box, the Activation Q input box is disabled. 
For HCD activation, no Q value is used for 
calculating voltages or amplitudes.

HCD Charge State1 The required absolute collision energy for 
fragmentation of given ions depends on their 
charge states. The collision energy is the lower the 
higher the charge state is. The algorithm for 
calculating the absolute collision energy is based 
on empirical data taken from measurements on 
peptides. For example, the required absolute 
energy to fragment [M+2H]2+ ions is about 75% 
of that of the corresponding [M+H]+ ions. For a 
[M+3H]3+ ion, the value goes down to 60%. 

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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Scan Ranges

When HCD1 is selected as the activation method in the MSn Settings 
group box, the First Mass (m/z) is set to either 0.05×LastMass or 50, 
whichever is higher.

To take advantage of this, enter the charge state of 
the ions to be fragmented into the input box. To 
change the displayed value, click on the arrows in 
the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, 
you can enter a value in the spin box text field. 
You can set the HCD charge state to any value 
from 1 to 99. The default value is 1.
The HCD Charge State spin box is available only 
if HCD is selected as activation type1, regardless 
of the status of the Advanced Scan features. See 
Figure 2-11.

Figure 2-11. Define Scan dialog box with HCD selected as activation type

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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Centroid/Profile

With this pair of buttons, you switch between the Centroid and the 
Profile format. The Profile format for FTMS data is a compressed 
profile format. Topic “FT Profile Mode” on page 4-8 describes how to 
switch to full profile format for FTMS data for diagnostic purposes.

For further information, see also topic “Data Size of FT Raw Files” on 
page A-4.

Positive/Negative

With this pair of buttons, you can toggle between positive ion and 
negative ion polarity. Different FT transfer, storage, and mass 
calibration parameters are used for the different polarities.
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This section describes the elements of the Display menu that are 
different from the LTQ XL.

Spectrum Averaging

With this toggle, spectrum averaging can be switched on or off. If 
spectrum averaging is enabled the displayed spectrum is the moving 
average of several spectra before. Averaging FTMS scans is actually an 
averaging of transients. 

Use this functionality in analogy to ion trap scans:

1. In the Tune Plus window, choose Display > Spectrum Averaging > 
Settings… to display the Spectrum Averaging dialog box. See 
Figure 2-12.

2. Enter the number of transients to average into the spin box.

3. Click on OK to save your changes and close the dialog box.

Figure 2-12. Spectrum Averaging dialog box
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This section describes the elements of the Setup menu that are different 
from the LTQ XL.

FT Transfer Optics

The FT transfer parameters are only changed by an FT transmission 
calibration, which is usually only necessary when the hardware of the 
system has been modified. This dialog box displays the actual 
FTreadback values for the current scan mode. See Figure 2-13.

❖ To open this dialog box

• From the Tune Plus window, choose Setup > FT Ion Optics, or

• click on  in the Instrument Control toolbar.

Note If the instrument is equipped with the HCD option, the above 

icon is replaced by . ▲

Figure 2-13. FT Transfer Optics dialog box
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FT Injection Control

The Injection Control dialog box allows you to set the automatic gain 
control (AGC) target values. In addition, the Injection Control dialog 
box allows you to enable or disable the injection waveforms.

❖ To open this dialog box

• From the Tune Plus window, choose Setup > FT Injection Control, 
or

• click on  in the Instrument Control toolbar.

The Injection Control dialog box has two pages to enable an 
independent selection of target values for ion trap scans and FT scans.

Ion Trap Page

Recommended target values for the ion trap:

Full MS Target: 3e+04
SIM Target: 1e+04
MSn Target: 1e+04
Zoom Target: 3000

Figure 2-14. Ion Trap page of the Injection Control dialog box
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FT Page

For FTMS measurements, only the Full MS target, the SIM target, and 
the MSn target are used.

Recommended target values for the FT analyzer:

Note Lower target values than those listed above may be used to obtain 
shorter inject times. For MSn scans, lower target values may also 
improve the isolation/fragmentation efficiency. Higher target values 
than those listed above can be used to improve the dynamic range. 
However, target values far above the recommended settings may affect 
isolation/fragmentation efficiency and mass accuracy for the 
FTMS analyzer. ▲

Enable Full Scan Injection Waveforms

You can enable or disable the injection waveforms independently for ion 
trap and FT scans. 

If the injection waveforms are enabled, a filter is applied on the ions that 
are injected into the ion trap. The ions above and below the selected ion 
or ion range selected are rejected. This option is often useful if the ion 
trap is being filled with ions of greater or lesser mass than the ion mass 

Full MS Target: 5e+05
SIM Target: 5e+04
MSn Target: 2e+05

Figure 2-15. FT page of the Injection Control dialog box
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or ion mass range of interest. For example, this option can be used to 
remove high mass ions that are not of interest and to ensure that more 
target ions can enter the trap before the trap is full. 

Note The FT injection waveforms option only applies to full scan 
MS scans performed with the Orbitrap mass analyzer. In FT SIM and 
FT MSn scans, the injection waveforms are automatically enabled. ▲

FT Vacuum

The Vacuum dialog box allows you to monitor the vacuum system 
parameters. The Vacuum dialog box has two pages to enable an 
independent selection of displaying the vacuum data of the ion trap or 
the FT part.

Figure 2-16. Ion Trap page of the Vacuum dialog box

Figure 2-17. FT page of the Vacuum dialog box
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❖ To open this dialog box

• From the Tune Plus window, choose Setup > Vacuum…, or

• click on  in the Instrument Control toolbar.

FT Temperature Monitor

The FT Temperature Monitor dialog box allows to view the status of the 
FTMS analyzer temperature regulation. See Figure 2-18. Deviations of 
the actual temperature from the temperature setpoint can affect 
instrument performance. It is not possible to operate the instrument 
when the bakeout procedure is active.

❖ To open this dialog box

• From the Tune Plus window, choose Setup > FT Temperature 
Monitor…, or 

• click on  in the Instrument Control toolbar.

FT Lock Masses

Choose Setup > FT Lock Masses to display the Lock Masses dialog 
box. See Figure 2-10 on page 2-12. This dialog box allows entering and 
editing lock mass lists for positive and negative ion mode. See topic 
“Locking” on page 2-12 for details.

Figure 2-18. FT Temperature Monitor dialog box
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Tune Methods
Several parameters, like the ion source parameters, ion trap optics 
parameters, or AGC target values are stored in tune methods. This topic 
points out for which parameters a differentiation between ion trap and 
FTMS is made. The Tune Plus title bar displays the name of the current 
tune method. If you are not currently editing a preexisting tune method, 
the title bar displays the word Untitled. 

Parameters with Differentiation between Ion Trap and FT Scans

A differentiation between ion trap scans and FTMS scans is made for 
the following tune parameters.

AGC Target Values

They can be set and saved independently for these experimental modes 
(no differentiation between positive and negative ion polarity mode):

• Ion Trap Full MS Target

• Ion Trap SIM Target

• Ion Trap MSn Target

• Ion Trap Zoom Target

• FT Full MS Target

• FT SIM Target

• FT MSn Target

Microscans and Maximum Inject Time

They can be set and saved independently for these experimental modes:

• Ion Trap Full MS, positive ion mode

• Ion Trap SIM, positive ion mode

• Ion Trap MSn, positive ion mode

• Ion Trap Zoom, positive ion mode

• FT Full MS, positive ion mode

• FT SIM, positive ion mode 

• FT MSn, positive ion mode 

• Ion Trap Full MS, negative ion mode
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• Ion Trap SIM, negative ion mode

• Ion Trap MSn, negative ion mode

• Ion Trap Zoom, negative ion mode

• FT Full MS, negative ion mode

• FT SIM, negative ion mode 

• FT MSn, negative ion mode 

Inject Waveform Flags 

The flag whether the inject waveform is enabled or disabled can be set 
and saved independently for 

• Ion trap scans

• FT full scans.

Parameters without Differentiation between Ion Trap and FT Scans

No differentiation between ion trap scans and FT scans is made for all 
ESI parameters, and for all ion source and ion optics parameters. 

Parameters not saved in a Tune Method

All parameters that can be set in an instrument method are not saved in 
the tune method. Thus, the following parameters are not saved in a tune 
method:

• Analyzer (Ion Trap or FTMS)

• Mass Range (Low, Normal, or High)

• Scan Rate 

• Resolution 

• Scan Type (Full, SIM, SRM, CRM)

• Scan Range

• Polarity* (positive or negative)

• Data type* (centroid or profile)

* Only the data format (centroid or profile) and the ion polarity are 
saved in a tune file that are set after a new start of Tune Plus.
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Chapter 3 Calibrating the Instrument for 
FTMS Measurements

This chapter provides procedures to calibrate your LTQ Orbitrap 
Discovery for FTMS measurements. It contains the following topics:

• “Preliminary Remarks” on page 3-2

• “Calibration Files and their Backups” on page 3-3

• “Calibration Solutions” on page 3-4

• “Calibration and Tuning of the Ion Trap” on page 3-9

• “Automatic Calibration Page” on page 3-12

• “Semi-Automatic Calibration Page” on page 3-14

• “Check Calibration Page” on page 3-18

• “FT Manual Calibration Page” on page 3-21
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Preliminary Remarks
Preliminary Remarks
There are no specific tune procedures for the FTMS part. All FTMS ion 
transfer and excitation parameters are treated as calibration parameters 
and are determined in automatic calibration procedures.

In the automatic calibration, the FT transmission calibration and the 
FTmass calibration are automatically performed for all calibration 
ranges. In the semi-automatic calibration, it is possible to decide 
whether the transmission and/or mass calibration are performed only for 
the positive ion mode, only for the negative ion mode or for both 
polarities. See topics “Automatic Calibration Page” on page 3-12 and 
“Semi-Automatic Calibration Page” on page 3-14 for further details.

On the FT Manual page of the Calibrate dialog box, you can select your 
own calibration masses for FT ion transmission, storage transmission, 
and FT mass calibration. See topic “FT Manual Calibration Page” on 
page 3-21 for further details. 

Note It is recommended to use the semi-automatic calibration. ▲
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Calibration Files and their Backups
After a successful or partly successful calibration, the ion trap and 
FT calibration parameters are saved automatically. All ion trap and 
FT calibration parameters are stored in the calibration file 
master.LTQCal, which is located in the folder:

C:\Thermo\Instruments\LTQ\system\msx

Backup Current Calibration

It is possible to create a backup of the current calibration file manually 
or by choosing File > Backup Current Calibration in the Tune Plus 
window. The Backup Current Calibration and Restore Backup 
Calibration items work by copying the master.LTQCal to user.LTQCal 
and vice versa.

If a backup calibration user.LTQCal was already generated, the old 
user.LTQCal will be backed-up to a file named userXYZ.LTQCal. If 
you perform backup calibrations at regular intervals, then a history of 
your calibration files is generated in the folder:

C:\Thermo\Instruments\LTQ\system\msx

Using the Backup Calibration command regularly allows returning to 
previous calibrations in case a new calibration is suspected to have 
worsened instrument performance. 

Restore Backup Calibration

Upon Restore Backup Calibration, the calibration values saved in 
user.LTQCal are automatically downloaded to the instrument. 
Therefore, it is recommended to generate a current backup after a 
successful calibration. 

It is also recommended to use the Restore Backup Calibration 
command instead of the Restore Factory Calibration command 
because the backup calibration file is newer than the factory calibration 
file.

Note Pressing the reset button of the instrument loads the 
master.LTQCal file into the internal computer of the instrument. ▲
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Calibration Solutions
This section provides information about preparing the calibration 
solutions for the LTQ Orbitrap Discovery.

The positive ion mode calibration solution allows calibrating Thermo 
Scientific MS detectors with ESI source in positive ion mode. 
Supported instruments are the LTQ Orbitrap Discovery, other 
LTQ based hybrid instruments (LTQ FT, LTQ FT Ultra, and 
LTQ Orbitrap series), and the Exactive. The positive ion mode 
calibration solution covers a mass range from m/z 138 to m/z 1822 and 
is therefore usable for calibrations between m/z 50 and 2000.

The negative ion mode calibration solution allows calibrating Thermo 
Scientific MS detectors with ESI source in negative ion mode. 
Supported instruments are the LTQ Orbitrap Discovery, other 
LTQ based hybrid instruments (LTQ FT, LTQ FT Ultra, and 
LTQ Orbitrap series), and the Exactive. The negative ion mode 
calibration solution covers a mass range from m/z 265 to m/z 1880 and 
is therefore usable for calibrations between m/z 50 and 2000.

Obtaining Ready-to-Use Calibration Solutions

To free you from time-consuming mixing and dilution steps and to 
allow you to focus on data acquisition, Thermo Fisher Scientific has 
arranged with Sigma-Aldrich® that you can order ready-to-use 
calibration solutions from their website (www.sigma-aldrich.com). 
Table 3-1 shows the available calibration solution packages. 1 EA is a 
10 mL Teflon® bottle.

Note If you have not ordered from Sigma-Aldrich in the past, fill out an 
on-line My Profile form on the Sigma-Aldrich web site 
(www.sigma-aldrich.com) to request access to the site. ▲

Caution The prepared calibration solutions are light and temperature 
sensitive. They are shipped under dry ice. Store them in darkness and at 
-20 °C (-4 °F). ▲

Table 3-1. Available calibration solution packages

Calibration Solution Designation Product Number

Positive ion mode ProteoMass™ LTQ/FT-Hybrid ESI Pos. Mode CalMix MSCAL5-1EA (1 EA)
MSCAL5-10EA (10 EA)

Negative ion mode ProteoMass™ LTQ/FT-Hybrid ESI Neg. Mode CalMix MSCAL6-1EA (1 EA)
MSCAL6-10EA (10 EA)
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LTQ/FT-Hybrid Positive Mode Calibration Solution

The LTQ/FT-hybrid positive mode calibration solution consists of 
caffeine, MRFA, and Ultramark 1621 in an acetonitrile:methanol:water 
solution containing 1% acetic acid.

Note Vials of caffeine, MRFA, and Ultramark 1621 are included in the 
API accessory kit. To order more of these compounds, contact:

Sigma Chemical Company
P. O. Box 14508
St. Louis, Missouri, USA 63178-9916
Phone (800) 325-3010 (in the USA or Canada)

(314) 771-3750 (outside the USA or Canada)

Web site www.sigma-aldrich.com ▲

Caution Avoid exposure to potentially harmful materials.
Always wear protective gloves and safety glasses when you handle 
solvents or corrosives. Also contain waste streams and use proper 
ventilation. Refer to your supplier's Material Safety Data Sheet (MSDS) 
for proper handling of a particular solvent. ▲

❖ To prepare the positive mode calibration solution

1. Stock Solution: MRFA

Prepare a 1.5 mL stock solution of 166.7 pmol/μL MRFA in 50:50 
methanol:water as follows:

a. Obtain the vial of L-methionyl-arginyl-phenylalanyl-alanine 
acetate × H2O (MRFA) in your accessory kit. In this form, the 
MRFA sample has an average molecular weight of 607.7 u. 
Carefully weigh 3.0 mg of the MRFA sample.

b. Dissolve the MRFA sample in a total volume of 1.0 mL of 50:50 
methanol:water. Mix the solution (5.0 nmol/μL) thoroughly.

c. Transfer 50 μL of the 5 nmol/μL solution into a clean 
polypropylene tube.

d. Add 1.45 mL of 50:50 methanol:water to the tube. Mix this 
solution (166.7 pmol/μL) thoroughly.

e. Label the tube MRFA stock solution and store it in a freezer until 
it is needed.
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2. Ultramark 1621 stock solution

Prepare a 10 mL stock solution of 0.1% Ultramark 1621 in 
acetonitrile as follows:

a. Obtain the vial of Ultramark 1621 in your accessory kit.

b. Using a syringe, measure out 10 μL of Ultramark 1621, and 
dissolve it in 10 mL of acetonitrile. Mix the solution thoroughly.

c. Label the vial Ultramark 1621 stock solution and store it in a 
freezer until it is needed.

3. Positive mode calibration solution

Prepare 10 mL of the positive mode calibration solution as follows:

a. Obtain the 1 mg/mL stock solution of caffeine in 100% 
methanol that is provided in your accessory kit.

b. Pipet 200 μL of the caffeine stock solution into a 
light-protected, clean, dry 10 mL volumetric flask.

c. Pipet 100 μL of the MRFA stock solution into the flask.

d. Pipet 100 μL of the Ultramark 1621 stock solution into the 
flask.

e. Pipet 100 μL of glacial acetic acid into the flask. 

Note Using plastic pipet tips causes contamination of acid stock 
solutions that can introduce contaminants into the calibration 
solution. ▲

f. Pipet 5 mL of acetonitrile into the flask.

g. Bring the volume of the solution up to the 10 mL-mark on the 
flask with 50:50 methanol:water.

h. Mix the calibration solution thoroughly.

i. Optional: Transfer the solution to a light-protected, clean, dry 
vial.

j. Label the flask/vial Positive Mode Calibration Solution and store 
it in a freezer until it is needed.
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LTQ/FT-Hybrid Negative Mode Calibration Solution

The LTQ/FT-hybrid negative mode calibration solution consists of 
sodium dodecyl sulfate, sodium taurocholate, and Ultramark 1621 in an 
acetonitrile:methanol:water solution containing 1% acetic acid.

Note Vials of sodium dodecyl sulfate and sodium taurocholate are 
shipped with the instrument. Refer to the Material Safety Data Sheet 
(MSDS) for proper handling of these substances. To order more of these 
compounds, contact Sigma-Aldrich. See page 3-5. ▲

Caution Avoid exposure to potentially harmful materials.
Always wear protective gloves and safety glasses when you handle 
solvents or corrosives. Also contain waste streams and use proper 
ventilation. Refer to your supplier's Material Safety Data Sheet (MSDS) 
for proper handling of a particular solvent. ▲

❖ To prepare the negative mode calibration solution

1. Stock Solution: Sodium Dodecyl Sulfate

a. Obtain the vial of sodium dodecyl sulfate. In this form, the 
sample has an average molecular weight of 288.4 u. 

b. Prepare the stock solution of sodium dodecyl sulfate by 
dissolving 2.88 mg in 10 mL of 50:50 methanol:water.

c. Mix the solution (1.0 nmol/μL) thoroughly. 

d. Label the vial Sodium Dodecyl Sulfate stock solution (1 nmol/μL).

2. Stock Solution: Sodium Taurocholate

a. Obtain the vial of sodium taurocholate. In this form, the sample 
has an average molecular weight of 537.7 u.

b. Prepare the stock solution of sodium taurocholate by dissolving 
5.38 mg in 10 mL of 50:50 methanol:water.

c. Mix the solution (1.0 nmol/μL) thoroughly.

d. Label the vial Sodium Taurocholate stock solution (1 nmol/μL).

3. Stock Solution: Ultramark 1621

To prepare the Ultramark 1621 stock solution (0.1% Ultramark 
1621 in acetonitrile), refer to step 2 of topic ”LTQ/FT-Hybrid 
Positive Mode Calibration Solution” above.
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4. Negative Mode Calibration Solution

Prepare 10 mL of the negative mode calibration solution, as follows:

a. Pipet 100 μL of the Sodium Dodecyl Sulfate stock solution into 
a light-protected, clean, dry 10 mL volumetric flask.

b. Pipet 100 μL of the Sodium Taurocholate stock solution into 
the flask.

c. Pipet 100 μL of the Ultramark 1621 stock solution into the 
flask.

d. Pipet 100 μL of glacial acetic acid into the flask. 

Note Using plastic pipet tips causes contamination of acid stock 
solutions that can introduce contaminants into the calibration 
solution. ▲

e. Pipet 5 mL of acetonitrile into the flask.

f. Bring the volume of the solution up to the 10 mL-mark on the 
flask with 50:50 methanol:water.

g. Mix the solution thoroughly.

h. Optional: Transfer the solution to a light-protected, clean, dry 
vial.

i. Label the flask/vial Negative Mode Calibration Solution and store 
it in a freezer until it is needed.

Applicable Calibration Solutions for FT Manual Calibration

Because the FT Manual page of the Calibrate dialog box allows using 
your own calibration masses, it is possible to use custom calibration 
solution here. However, there are some requirements for the calibration 
masses. The scan ranges of the instrument need to be covered properly 
by the given masses.
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Calibration and Tuning of the Ion Trap 
This chapter describes the calibration and tuning of the ion trap for 
FTmeasurements.

Calibration of the Ion Trap

To perform an FT calibration, the ion trap has to be successfully 
calibrated before. It is very important that the electron multiplier gain is 
correctly calibrated because the AGC prescan is performed in the ion 
trap. Thus, the electron multiplier gain calibration should be checked 
before an FT calibration is performed.

Note It is not necessary to use the positive mode calibration solution to 
perform a multiplier gain calibration. It is sufficient to use an 
MRFA solution (for example 5×10-6 M in 100% methanol, 1% acetic 
acid). ▲

For the ion trap calibrations, the positive mode calibration solution or 
the negative mode calibration solution can be used.

Tuning the Ion Trap for Positive Ion Mode

For the positive ion mode, it is recommended to perform an automatic 
tuning of m/z 524 at a Full MS Target of 1e4–3e4. Use the positive 
mode calibration solution or the negative mode calibration solution 
with the settings in the Define Scan dialog box that are shown on 
Figure 3-1 on page 3-10.

After the automatic tuning, a manual adjustment of the tube lens should 
be used to get an ion trap spectrum in the scan range m/z 130–2000. 

The spectrum should look similar to the spectrum shown in Figure 3-2 
on page 3-10. Make sure the peaks at m/z 138, 195, 524, and the 
highest Ultramark peaks are all present, ideally above 30% of the base 
peak.

Note The peak at m/z 138 should have a height of more than 10%. Run 
an automatic ion trap tuning on m/z 138 if this signal is too weak. ▲

The inject time should be stable and less than 1 ms (if a Full MS target 
of 1e4 is used). Do not forget to save the tune method after a successful 
tuning.
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Figure 3-1. Recommended settings in the Define Scan dialog box for an automatic tuning of the ion trap

Figure 3-2. Ion trap spectrum of the positive ion mode calibration solution, scan range m/z 130–2000, positive ion 
polarity mode

* Label for m/z 138.00 added manually

*
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Tuning the Ion Trap for Negative Ion Mode

For the negative ion mode, it is recommended to perform an automatic 
tune of m/z 514 at a Full MS Target of 1e4–3e4. Use the negative mode 
calibration solution with the settings shown in Figure 3-1 on page 3-10.

After the automatic tuning, a manual adjustment of the tube lens should 
be used to get an ion trap spectrum in the scan range m/z 150–2000. At 
m/z 265 is the base peak (100%) and the highest Ultramark adduct ion 
peaks are at about 80%, as shown in Figure 3-3. 

If the tube lens is set to a very high negative voltage, in-source 
fragmentation of the Ultramark adduct ions may occur. Thus, if you 
observe rather ions at m/z 906, 1006, … than ions at m/z 1280, 1380, 
… the tube lens setting has to be decreased. The inject time should be 
stable and less than 1 ms (if a target of 1e4 is used). Do not forget to 
save the tune method after a successful tuning.

Figure 3-3. Ion trap spectrum of the negative ion mode calibration solution, scan range m/z 150–2000, negative ion 
mode
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Automatic Calibration Page
The Automatic page of the Calibrate dialog box (see Figure 3-4) allows 
you to perform an automatic calibration of all the calibration parameters 
including all ion trap calibrations and all FT calibrations.

In an automatic calibration the FT calibration procedures are performed 
automatically one after another, following the ion trap calibration. To 
perform an automatic calibration, the negative mode calibration 
solution has to be used.

The calibration masses and all experimental parameters (for example, 
target values, scan ranges, or resolution settings) are set automatically 
and cannot be influenced by the user. 

Figure 3-4. Automatic page of the Calibrate dialog box
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Note Usually, you do not need to perform a complete ion trap 
calibration or an FT ion transmission calibration unless the hardware is 
modified in some way. However, it is necessary to repeat the electron 
multiplier calibration and the FT mass calibration on a regular basis. 
Thus, in the most cases it is not recommended to perform an automatic 
calibration of the LTQ Orbitrap Discovery. In this case, all calibrations 
are performed, which takes about 1 hour. To run a multiplier gain 
calibration or an FTmass calibration (which takes only some minutes), 
it is recommended to use the semiautomatic calibration. ▲
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Semi-Automatic Calibration Page
The Semi-Automatic page of the Calibrate dialog box (see Figure 3-5) 
allows you to select specific calibration parameters to calibrate, for 
example only the ion trap calibrations or only the FT calibrations. For 
FT calibrations, it is also possible to differentiate between positive and 
negative ion mode.

To calibrate one or more selected parameters, clear the Select All check 
box to make the individual calibration parameters available. Select the 
parameter(s) you want to calibrate, then click on Start.

Figure 3-5. Semi-Automatic page of the Calibrate dialog box
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For example:

• To run a complete automatic calibration (ion trap and FT), select 
the Select All check box. Then, click on Start. This is analogous to 
the automatic calibration. As already described before, it is not 
recommended to perform an automatic calibration of the 
LTQ Orbitrap Discovery if not necessary because all calibrations are 
performed, which takes about 1 hour.

• To run an automatic calibration of the ion trap, select the Select All 
- Ion Trap check box. Then, click on Start.

• To run an automatic calibration of the FT part, select the Select All - 
FT check box. Then, click on Start.

• To run an FT mass calibration, select the Mass Calibration check 
box. Then, click on Start.

In a semi-automatic calibration, the selected FT calibration procedure(s) 
are performed automatically one after another. 

All calibrations apart from the FT calibrations for the negative ion mode 
can be performed with either the positive mode calibration solution or 
the negative mode calibration solution. To run the FT ion transmission 
and/or mass calibration for the negative ion mode, the negative mode 
calibration solution has to be used. 

The calibration masses and all experimental parameters like target 
values, scan ranges, resolution settings, inject waveforms etc. are set 
automatically and cannot be influenced by the user.
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HCD Calibration

The Semi-Automatic page of the Calibrate dialog box allows calibrating 
the HCD collision energy and the HCD transmission for the positive 
and negative ion mode as well.1 See Figure 3-6.

Note Calibrate the HCD transmission before you calibrate the 
HCD collision energy. ▲

HCD Collision Energy

This check box allows you to specify whether or not to calibrate the 
HCD collision energy. To calibrate the HCD collision energy, first make 
this check box available by clearing the Select All check box. Then, select 
the HCD Collision Energy check box.

HCD Transmission

This check box allows you to specify whether or not to calibrate the 
HCD transmission. To calibrate the HCD transmission, first make this 
check box available by clearing the Select All check box. Then, select the 
HCD Transmission check box.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.

Figure 3-6. Semi-Automatic page with HCD option installed
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Advanced Calibration Features

When the Advanced Calibration Features in the Control menu are 
enabled, the Semi-Automatic page of the Calibrate dialog box 
additionally allows calibrating the storage transmission and the 
FT transmission for the positive and negative ion mode as well. See 
Figure 3-7.

Note Do not calibrate the FT transmission and/or the storage 
transmission unless the respective calibration checks have failed. ▲

Figure 3-7. Semi-Automatic page of the Calibrate dialog box (Advanced 
Calibration Features enabled)
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Check Calibration Page
The Check page of the Calibrate dialog box allows you to automatically 
check several calibration settings. See Figure 3-8.

All calibration checks apart from those for the FT negative ion mode 
can be performed with either the negative mode calibration solution or 
the positive mode calibration solution. To check the FT calibrations in 
the negative ion mode, the negative mode calibration solution has to be 
used.

The calibration masses and all experimental parameters like target 
values, scan ranges, resolution settings, etc. are set automatically.

At the conclusion of the check procedure, the LTQ Orbitrap Discovery 
MS detector displays a message that indicates whether the parameter(s) 
are calibrated properly or not.

Figure 3-8. Check page of the Calibrate dialog box
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Using the Check page of the Calibrate dialog box, you can select the 
following parameters:

1Select All This check box allows you to specify whether 
or not to check all calibration parameters. To 
check all calibration parameters, select the 
Select All check box. In this case, all ion trap 
calibration parameters and all FT calibration 
parameters are checked. You can also check 
each calibration parameter individually. To 
make the individual calibration parameters 
available, clear the Select All check box.

Select All Ion Trap This check box allows you to specify whether 
or not to check the calibration of only the ion 
trap parameters.

Select All-FT This check box allows you to specify whether 
or not to check the calibration of only the 
FT ion transfer optics and mass analyzer.

Transfer Multipole RF 
Frequency

This check box allows you to specify whether 
or not to check the frequency of the 
RF voltage of the transfer multipole in the 
FT transfer ion optics.

Storage Multipole RF 
Frequency

This check box allows you to specify whether 
or not to check the frequency of the 
RF voltage of the storage multipole in the 
FT transfer ion optics. 

Positive Ion Mode This check box allows you to specify whether 
or not to check the FT ion transmission 
calibration and FT mass calibration for the 
positive ion mode.

Negative Ion Mode This check box allows you to specify whether 
or not to check the FT ion transmission 
calibration and FT mass calibration for the 
negative ion mode.

Storage Transmission This check box allows you to specify whether 
or not to check the ion storage transmission 
calibration. The storage transmission is 
checked by transferring ions form the ion trap 
to the ion storage device and back, then 
scanning in the ion trap. The FT storage 
transmission calibration can be checked for the 
positive and negative ion mode independently.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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1

The Last Check Date readback column gives the date of the last 
successful check for each item. If a check is performed that fails, the last 
successful check date still appears in the Last Check Date readback 
column. The last successful check continues to be in effect in the 
instrument. However, the result column will show a red x mark 
indicating that the current attempt check has failed or was aborted.

FT Transmission This check box allows you to specify whether 
or not to check the FT ion transmission 
calibration. The ion transmission from the ion 
trap to the Orbitrap is checked by means of 
the calibration masses in SIM experiments at 
different AGC target values. The 
FT transmission calibration can be checked for 
the positive and negative ion mode 
independently.

Mass Calibration This check box allows you to specify whether 
or not to check the mass calibration of the 
Orbitrap mass analyzer. By doing so, the 
current mass calibration is checked, i.e it is a 
check of the external mass calibration. The 
FTmass calibration can be checked for the 
positive and negative ion mode independently.

HCD Collision Energy This check box allows you to specify whether 
or not to check the HCD collision energy 
calibration. To check the HCD collision 
energy calibration, first make this check box 
available by clearing the Select All check box. 
Then, select the HCD collision energy check 
box.1

HCD Transmission This check box allows you to specify whether 
or not to check the HCD transmission 
calibration. To check the HCD transmission 
calibration, first make this check box available 
by clearing the Select All check box. Then, 
select the HCD transmission check box.1

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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FT Manual Calibration Page
The FT Manual page of the Calibrate dialog box allows to perform or to 
check an FT transmission calibration, storage transmission calibration, 
and an FT mass calibration with user-defined calibration masses. See 
Figure 3-9.

All experimental parameters like target values, scan ranges, resolution 
settings, etc. must be set manually.

Note When starting from the FT Manual page, the calibration is 
performed for the currently selected polarity only. ▲

Figure 3-9. FT Manual page of the Calibrate dialog box
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Mass List Group Box

The calibration masses for manual calibration can be defined in the 
corresponding mass list on the FT Manual page of the Calibrate dialog 
box. Mass lists can be imported and exported via the Instrument 
Configuration page, see further details in Chapter 6: “Instrument 
Configuration”.

Note Ensure that you have calculated the calibration masses with 
sufficient accuracy (sub ppm). ▲

Factory-Supplied Mass Lists

There are also two factory supplied mass lists, calmix_positive (factory) 
and calmix_negative (factory). They contain the exact masses of all main 
ion peaks, which should appear if the negative mode calibration solution 
is used in positive or negative ion mode, respectively.

Name This list box lists the names of the factory supplied and user 
created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions that 
you are using to calibrate the Orbitrap mass analyzer. You 
can select an existing mass list in the Name list box, or you 
can create or modify a mass list by clicking on it and editing 
the entries in the Mass List table. 

Save Click on Save to save the mass list with the name that is 
selected in the Name list box.

Save As Click on Save As a to save the mass list with a new name.

Delete Click on Delete to delete the mass list that is selected in the 
Name list box.
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Chapter 4 Performing Diagnostics/Checks

This chapter describes several diagnostic procedures for the 
LTQ Orbitrap Discovery. It contains the following topics:

• “System Evaluation Procedures” on page 4-2

• “Toggles” on page 4-6

• “Set Device” on page 4-10

• “Display Settings” on page 4-12
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System Evaluation Procedures
The System Evaluation page in the Diagnostics dialog box allows you to 
evaluate system performance. See Figure 4-1.

Besides several ion trap relevant system evaluation procedures, you can 
perform various FT system evaluation procedures, which are described 
in the following topics.

FT Dynamic Range Test

This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the positive mode calibration solution 
or a MRFA alone solution (for example 5×10-6 M in 
100% methanol/water, 1% acetic acid). This test determines the 
signal-to-noise ratio of an isolated MRFA signal.

FT Energy Dependence Evaluation

This procedure determines the change in mass calibration when varying 
the ion energy (HV Offset). This procedure can help evaluating the 
FTMS analyzer components.

Figure 4-1. System evaluation page of the Diagnostics dialog box
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FT HCD Collision Cell Ejection Evaluation

This procedure analyzes the dynamics of ions in the HCD collision cell. 
This procedure can help evaluating the HCD collision cell 
components.1

FT High Mass Range Target Compensation

This procedure determines an AGC target compensation factor, which 
ensures that the FT mass calibration is still valid if the instrument is set 
into the high mass range mode. The resulting compensation factor will 
be saved in the calibration file. Usually, it is sufficient to run this 
procedure once. It is not necessary to repeat this procedure on a regular 
basis. It is recommended to use the positive mode calibration solution 
for this test. However, you can also use any other solution that gives 
reasonable ion signals at 1000 < m/z < 2000.

FT Isolation Test

This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the positive mode calibration solution 
or a MRFA alone solution (for example 5×10-6 M in 100% 
methanol/water, 1% acetic acid). This test is analogous to the “Check of 
the ion isolation waveform” on the Check page of the Calibrate dialog 
box. Here, the isolation of m/z 525.3 is performed at a target of 2000 
and analyzed by the ion trap. In contrast to this, the FT isolation test is 
performed at higher targets and uses the FT analyzer. Thus this test 
determines the maximum AGC target value that allows performing a 
unit isolation of m/z 525.3 at the presence of m/z 524.3 and 526.3.

FT Noise Test

This test determines resistant noise peaks in the selected scan range. In 
this test ions are “switched off ” automatically. At the conclusion of the 
FT noise test, a list of resistant noise peaks is displayed in the Testing 
text.

FT Preamp Evaluation

This evaluation allows checking the basic FTMS analyzer signal 
detection path. The instrument needs to run in FTMS analyzer mode. It 
is recommended to switch to diagnostic transient view, see topic 
“FT Include Transients” on page 4-7.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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During the evaluation, the preamplifier input protection switches are 
activated with a period of 100 ms. This switching can be observed as 
periodic incidences in the transient if the electronic signal path is 
operational. 

FT Pulser Evaluation

This procedure tests characteristics of the high voltage pulser. This 
procedure can help evaluating the FTMS analyzer electronics.

FT Sensitivity Test

The FT sensitivity test is only applicable for an infusion experiment 
with reserpine. The test assumes that a reserpine solution of 5×10-9 M 
(100% methanol, 1% acetic acid) is used. The following test are 
performed one after another:

1. SIM of m/z 609.3 using the ion trap as analyzer and an AGC target 
of 2e+03. 

2. SIM of m/z 609.3 using the Orbitrap detector as analyzer and an 
AGC target of 5e+03.

3. SIM of m/z 609.3 using the Orbitrap detector as analyzer and an 
AGC target of 5e+04.

4. MS/MS of m/z 609.3 using the Orbitrap detector and an 
AGC target of 5e+04.

The test fails

1. if the inject time, which is necessary to reach the selected 
AGC target value, is too high; 

2. if the ratio of the reserpine signal to the overall signal inside the 
SIM window is too low; 

3. if the ion transmission from the ion trap to the Orbitrap detector is 
too low, or 

4. if the intensity of the product ions of reserpine is too low.

FT Stability Test

This test is applicable for an infusion experiment with any sample 
solution. This test procedure checks the stability of the FT TIC (total 
ion current) detected in the selected scan range by means of 600 scans. 
In principle, the test can be performed at any experimental conditions. 
It is recommended, however, to perform this test in Full scan mode 
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using one microscan, a resolution setting of 30000 and a FT Full MS 
Target of 5e+05 or 1e+06. At the conclusion of the FT stability test, the 
AGC stability and the corresponding signal variation is displayed.

FT Temperature Control Evaluation

This evaluation procedure allows examining the temperature regulation 
behavior of the instrument by intentionally driving temperatures to 
extreme values. 

Note The evaluation will usually take more than 12 hours where no 
measurements can be done. After stopping the evaluation, the 
instrument needs to stabilize temperatures for several hours before high 
mass accuracy measurements can be started. ▲ 

FT Temperature Monitor

Mass accuracy of the Orbitrap detector with external mass calibration 
depends on a stable temperature of the analyzer and the electronic 
components. This evaluation plots a history of the temperature 
regulation results to the Graph view, see topic “Graph View” on 
page 2-5.

Figure 4-2. Result of the FT stability test displayed in the Graph view
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Toggles
The Toggles page in the Diagnostics dialog box allows you to toggle 
[change] a subsystem from one state to another state. See Figure 4-3.

❖ To display this page

From the Tune Plus window, choose Diagnostics > Diagnostics > 
Tools > Toggles.

Caution All toggles should only be used for diagnostic purposes. The 
functionality of the LTQ Orbitrap Discovery may be harmed if a toggle 
is switched to a status that differs from its default value. ▲

If one of the FT toggles is (accidentally) different from its default value 
during data acquisition, the FT Analyzer Settings of the Scan Header of 
a raw file contains a reference to this. See Appendix A: “Miscellaneous 
Information” for further details.

Note The status of a toggle is not saved in the tune method and is set 
back to its default value after an instrument reset. The toggle state 
shown by the radio buttons next to the list box does not necessarily 
correspond to the actual settings. ▲

Figure 4-3. Toggles page of the Diagnostics dialog box
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FT Analyzer Ion Gauge

With this toggle, the ion gauge for the FT analyzer vacuum can be 
disabled manually for diagnostic purposes. The default setting is On 
(enabled).

FT Analyzer Temperature Control 

With this toggle, the FT analyzer temperature control regulation 
electronics can be disabled for diagnostic purposes. The default setting is 
On (enabled). 

FT Apodization

With this toggle, the apodization can be switched on or off. The default 
setting is On.

FT HCD Collision Gas

With this toggle, the HCD collision gas can be switched on or off. The 
default setting is On. The default setting can be changed in the 
Instrument Configuration application.1

FT Include Transients

If this toggle is on, it is possible to display transients in the Spectrum 
view by choosing Show FT Transient in the shortcut menu of the 
Spectrum view. The menu is displayed when you right-click anywhere 
on that page. See topic “Spectrum View” on page 2-3 for further details. 

Note A transient view is only possible if profile (instead of centroid) is 
chosen as data format. ▲

During transient display in Spectrum view, the x-coordinate is 
misleadingly labeled with m/z instead of milliseconds. The default 
setting is Off.

Note It is not possible to acquire transients into an Xcalibur raw file. ▲

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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FT Manual Calibration for Single Range

This toggle can be used to influence the behavior of the FT manual 
calibration procedures, refer to topic “FT Manual Calibration Page” on 
page 3-21. In the default behavior, the FT manual calibration 
procedures calibrate the whole scan mass range for the actual polarity.

In order to be able to use non-standard calibration substances that cover 
a limited mass range only, advanced users may enable this toggle. With 
this toggle enabled, there is no check for mass range coverage of 
reference mass lists. Instead, the instrument stays in the chosen mass 
range and calibrates this range only. With this toggle enabled, the user is 
responsible to cover the whole mass range needed, possibly by 
calibrating manually in several steps with different substances. If the 
performed FT manual calibration is not suitable for the scan settings 
used in an FTMS analyzer data acquisition, the scan header of a raw 
data file contains a reference to this. See Chapter A: “Miscellaneous 
Information” for further details.

FT Profile Mode

With this toggle you can select whether the FT profile mode 
corresponds to a Full Profile format or to a Reduced Profile format. It is 
recommended to use the Reduced Profile Mode for data acquisition 
because the data size of the raw file is significantly decreased by using the 
Reduced Profile. The default setting is Reduced. For further 
information, see also topic “Data Size of FT Raw Files” on page A-4. 

FT SIM and MSn Injection Waveforms

Usually, for FT SIM scans and FT MSn scans the injection waveforms 
are automatically enabled. It is not possible to change this setting in the 
Injection Control dialog box. With this toggle, it is possible to disable or 
enable the injection waveforms manually for diagnostic purposes. The 
default setting is On. 

FT Storage Evaluation Mode

This toggle can be used to test the characteristics of ion transfer 
components for the FTMS analyzer. The default setting is On 
(enabled).
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FT Storage Multipole RF

This toggle can be used to switch the FT storage multipole RF on or off. 
The default setting is On. If the multipole RF is switched on, the 
corresponding blue diagnostic LED of the ion optic supply board 
should be on (indicating that the RF1 generator is switched on). See the 
LTQ XL Hardware Manual for further details.

FT Transfer Multipole RF

This toggle can be used to switch the FT transfer multipole RF on or 
off. The default setting is On. If the multipole RF is switched on, the 
corresponding blue diagnostic LED of the ion optic supply board 
should be on (indicating that the RF2 generator is switched on). See the 
LTQ XL Hardware Manual for further details.

FT View Frequency

If this toggle is switched on, the FT spectrum is shown as a frequency 
spectrum. If the system is on and the FT is chosen as analyzer, the 
frequency spectrum is displayed in the Spectrum view. The default 
setting is Off.

Note The x-coordinate is misleadingly labeled with m/z instead of 
kHz. ▲

This toggle is for diagnostic purposes only. Therefore, it is not possible 
to acquire frequency spectra.

FT Zero Offset

If this toggle is switched on, an offset is added to the spectrum. This 
enables to view the full noise band. The default setting is Off, if the 
Reduced Profile format is used. The setting is On, if the Full Profile 
format is used.
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Set Device
Set Device
The Set device page of the Diagnostics dialog box allows selecting 
devices or experimental parameters from the list and setting the value for 
that device or parameter. See Figure 4-4. 

❖ To set a device

1. Select the device or parameter you would like to set from the Device 
list box.

2. Enter the device parameter's value in the text box below the Device 
list box.

3. Click on Set to apply the change to the device value or parameter.

Note The value in the text box below the Device list box, which is 
displayed after the call of this page, does not necessarily correspond to 
the actual value. ▲

There are several FT relevant parameters, which may be changed from 
this page. 

Figure 4-4. Set device page of the Diagnostics dialog box
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Note After an instrument reset, the manual settings are overwritten with 
the corresponding calibration parameters. ▲

Caution Changing the instrument settings can harm the functionality of 
the LTQ Orbitrap Discovery, especially if followed by saving the 
calibration parameters (manually or at conclusion of a calibration 
procedure). Thus, this option should only be used by very advanced 
users. ▲

FT Lockmass Abundance

This device allows changing the target value of an injected lock mass 
relative to the actual FT scan target value. The recommended default is 
10 percent. Also refer to topic “Locking” on page 2-12.

FT Mass Check Test Duration

This device allows changing the duration of FT Manual mass calibration 
checks, see topic “FT Manual Calibration Page” on page 3-21. By 
changing this value, a long-term mass stability evaluation can be run. 
The default procedure of the FT manual mass calibration check is to 
perform 100 scans checking the mass accuracy. The test duration may 
be extended to up to 72 hours. The default behavior can be restored by 
setting the duration to zero. If the duration is set between two and 
24 hours, the FT manual mass calibration check will specially control 
the syringe pump in order to allow running long-term test with a single 
syringe filling. For durations above 24 hours, it is assumed that an 
external syringe pump is used.

Setting new FT Transfer Optics Parameters

There are two set device items that can be used to overwrite the 
FT optics values:

• FT Optics Device Address

• FT Optics Set Value

These values are originally determined during instrument calibration 
and set automatically. Overwriting calibration values will influence 
instrument performance and should only be done for diagnostic 
purposes. 

Note If you have changed FT transfer optics settings, it is recommended 
to perform a full FT instrument calibration afterwards to assure good 
instrument performance. ▲
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Display Settings
The Display Settings page in the Diagnostics dialog box allows you to 
select a variety of instrument settings for display. See Figure 4-5. Select 
the instrument settings you want to display and click Start. The 
LTQ Orbitrap Discovery displays the requested instrument settings in 
the Testing text box. 

The following FT relevant instrument settings can be displayed:

• FT calibration settings

• FT diagnostics

• FT instrument settings

Display FT Calibration Settings

Displays all FT relevant calibration parameters in the diagnostics text 
box.

Display FT Diagnostics

Displays current diagnostic readback values of the FT electronic boards.

Figure 4-5. Display settings page of the Diagnostics dialog box
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Display Settings
Display FT Instrument Settings

Displays the current values of those FT instrument settings that depend 
on the scan range and ion polarity mode and can be changed manually 
on the Set Device page of the Diagnostics dialog box.
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Chapter 5 Instrument Setup

This chapter explains the “Locking” feature in automated runs and 
describes the FT relevant topics of the data dependent settings in the 
Instrument Setup. It contains the following topics:

• “Using Locking in Automated Runs” on page 5-2

• “Data Dependent Settings” on page 5-3
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Using Locking in Automated Runs
Using Locking in Automated Runs
To use locking in an automated run, use the Instrument Setup program. 

Note Refer to topic “Locking” on page 2-12 for a basic description on 
using locking with FTMS analyzer scans. ▲

The Lock Mass List button on the right side of the Segment settings 
group box displays a lock mass list editor dialog. See Figure 2-10 on 
page 2-12. Segment-related lock masses can be entered here. There are 
separate lists for positive ion and negative ion mode. If the lock mass for 
a segment is empty, no locking will be applied in the run and the 
external mass calibration will be used.

Figure 5-1. MS Detector Setup View – MS Detector Setup Page
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Data Dependent Settings
This section describes the FT relevant topics of the data dependent 
settings in the Instrument Setup.

Using Masses instead of Mass-to-Charge Ratios

Figure 5-2 shows the Global page of the Data Dependent Settings dialog 
box. It allows you to select dependent scan settings that apply to all 
dependent scans. 

Instrument Setup allows using mass units in the input fields of dialog 
boxes instead of mass-to-charge ratios. To enable this feature, select the 
check box on the Global page and click OK. From now on, you can 
enter just the uncharged masses of the most intensive peaks. It is not 
necessary anymore to consider all possible charge states. LTQ Orbitrap 
Discovery determines the charge state from the full scan and converts 
these masses to mass-to-charge ratios. Enabling this feature affects the 
parameters in the data dependent settings as described below.

Figure 5-2. Data Dependent Settings dialog box – Global page
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Mass Units in Global Parameters

Global Mass Range is interpreted as masses. 
Therefore, a mass range of m/z 500–2000 
will allow selecting a M2+ peak at m/z 251, 
but will ignore a M2+ peak at m/z 1001.

Mass Widths Exclusion mass widths are interpreted as 
masses. Note that the isotope exclusion 
functionality will be based on masses. 
Therefore, if both a M2+ and M3+ peak 
show up for the same peptide in a full scan, 
only the more abundant charge state will 
be selected.
Parent mass widths are interpreted as 
masses.
Reject mass widths are interpreted as 
masses.

Dynamic Exclusion Dynamic exclusion mass widths are 
interpreted as masses. When a peak is 
dynamically excluded, the neutral mass is 
put on the list. Therefore, other charge 
states of the same mass will be excluded in 
future cycles.

Mass Tags Mass deltas are interpreted as masses. The 
mass deltas are converted back to 
mass-to-charge ratios based on the detected 
charge state of the selected peak. The 
partner must also have the same charge 
state. Mass tolerances are based on 
exclusion mass widths.

Isotopic Data Dependence Mass differences are interpreted as masses. 
The mass differences are converted back to 
mass-to-charge ratios based on the detected 
charge state of the selected peak.

Neutral Loss Neutral loss mass widths are interpreted as 
masses.

Product Product mass widths are interpreted as 
masses.
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Mass Units in Segment Parameters

Parent Mass List Input will be interpreted as neutral masses 
– not [M+H]+ or [M-H]+. If “MS Charge 
State” is specified in the mass list, this value 
is used to convert the mass back to a 
mass-to-charge ratio. If this is not specified, 
masses are converted to mass-to-charge 
ratios based on all charge states that are not 
on the rejection list. “4 and up” is an 
allowed charge state, but the search is only 
performed for 4, and not 5, 6, etc. If more 
than one charge state is identified, only the 
most abundant is selected.

Reject Mass List Input will be interpreted as neutral masses 
–  not [M+H]+ or [M-H]+.

Charge State Because masses must be converted back to 
mass-to-charge ratios, the charge state must 
be known for any peak that is analyzed. 
Therefore, rejection of unassigned charge 
states is automatically enforced.

Neutral Loss Masses are interpreted as masses. The 
charge state used to convert back to 
mass-to-charge ratio is based on the peak 
being analyzed. The charge state of the 
potential partner must match the charge 
state of the peak.

Product Mass List Input will be interpreted as neutral masses 
–  not [M+H]+ or [M-H]+.

Add/Sub Mass is interpreted as a mass and is 
converted to mass-to-charge based on the 
charge state of the selected peak.
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Data Dependent Settings
Preview Mode

Figure 5-3 shows the Current Segment page of the Data Dependent 
Settings dialog box.

If the preview mode for FTMS master scans is enabled on the Current 
Segment page, the data dependent decision is made on the basis of the 
FTmaster scan with lower resolution to increase the duty cycle. The 
resolution of the FTMS scan itself is not changed. Because the high 
resolution is usually not required to make the data dependent decision, 
it is recommended to enable the preview mode. 

To prevent making data dependent decisions on basis of 
lower-resolution preview spectra, disable this option. For example, if 
there are ions with high charge states to be examined, and the data 
dependent settings require charge state recognition of precursor ions, 
this might be a reason to turn off this option. Otherwise, the high 
charge state clusters may not be resolved and charge states will not be 
recognized in preview mode.

Figure 5-3. Data Dependent Settings dialog box – Current Segment page
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Monoisotopic Precursor Selection

Figure 5-4 shows Charge State page of the Data Dependent Settings 
dialog box.

If the monoisotopic precursor selection is enabled on the Charge State 
page, the data dependent scan is only performed for one molecular ion 
of the corresponding overall isotope distribution if Dynamic Exclusion 
is enabled. 

This check box is only available on the Charge State page if the 
Advanced Features are turned on in the LTQ Orbitrap Discovery menu 
of the Instrument Setup.

Note The algorithm for isotopic cluster recognition will handle correctly 
only such isotope distributions where the third peak (A + 2) is lower in 
intensity than the second peak (A + 1). For more complex isotope 
patterns (for example, ions containing Sn, Br, or multiple Cl atoms), it 
is recommended to clear the Enable monoisotopic precursor selection 
check box. ▲

Figure 5-4. Data Dependent Settings dialog box – Charge State page (Advanced Features on)
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Use Non-Peptide Monoisotopic Recognition

This check box is only available if monoisotopic precursor selection is 
active. If monoisotopic precursor selection is active and this box is not 
checked, precursor ions in FT master scans must match peptide-type 
isotopic distribution in order to identify the monoisotopic peak. If this 
box is selected, monoisotopic peaks will also be identified for small 
molecules and precursor ions with non-peptide-type isotopic 
distributions.

Data Dependent FT SIM Scans 

A data dependent FT SIM scan is performed around the center mass 
determined in a previous reference scan event if the check box “Same 
MS order as referenced scan event” is selected on the Current Scan 
Event page as shown in Figure 5-5. 

Figure 5-5. Data Dependent Settings dialog box – Current Scan Event page
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Data Dependent Settings
Repeat previous Scan Event with HCD

The Repeat previous scan event with HCD check box will only be 
available when all of the following requirements are fulfilled:

• The instrument is equipped with the HCD option and the 
HCD option has been enabled on the FT Settings page. (See 
page 6-3.)

• FTMS is selected as the mass analyzer for the current scan event.

• A neutral loss or product ion list is specified for the referenced scan 
event.

• Either option From neutral loss list or From product list is selected.

• HCD is selected as activation type on the Activation page. See 
page 5-11.

Select the check box to repeat the previous scan event with 
HCD activation type. A typical experiment to use this feature would be 
to trigger an HCD fragmentation experiment with a neutral loss 
observed in an ion trap MS/MS experiment. See Figure 5-6. 

Figure 5-6. Current Scan Event page – Repeat previous scan event with HCD
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Data Dependent Settings
Scan Width

The scan width of the data dependent FT SIM scan can be selected on 
the Scan widths page of the Data Dependent Settings dialog box. See 
Figure 5-7.

Figure 5-7. Data Dependent Settings dialog box – Scan Widths page
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Data Dependent Settings
Activation Type

On the Activation page of the Data Dependent Settings dialog box, the 
Activation type list box allows you to specify how the ions are activated 
for fragmentation during a data dependent experiment. See Figure 5-8. 
It has the following options:

• CID (Collision-induced dissociation)

• PQD (Pulsed-Q dissociation)

• HCD (higher energy CID)1

Use HCD to obtain triple quadrupole-like fragment ion spectra. If 
you select HCD, the Activation Q spin box becomes unavailable.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.

Figure 5-8. Data Dependent Settings dialog box – Activation page
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FT HCD

The FT HCD page of the Data Dependent Settings dialog box will only 
be available when FTMS is selected as the mass analyzer for the current 
scan event. See Figure 5-9.1

The FT HCD page offers you two modes for choosing the first mass of 
the dependent scan:

• a mass with a fixed m/z value

To change the m/z value, click on the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set m/z to any value from 50 to 4000; default is 100. Alternatively, 
you can enter a value in the spin box text field.

• a mass with an m/z value that is relative to the precursor mass.

To change the percentage, click on the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set the percentage to any value from 0 to 4; default is 0.25. 
Alternatively, you can enter a value in the spin box text field.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.

Figure 5-9. Data Dependent Settings dialog box – FT HCD page
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Data Dependent Settings
MSn Settings for HCD Experiments

Similar to the Define Scan dialog box, the Instrument Setup allows 
selecting the Activation type (CID/PQD/HCD1). See topic 
“MSn Settings” on page 2-13. Use HCD to obtain triple 
quadrupole-like fragment ion spectra. If you select HCD as activation 
type, the HCD charge state input box becomes available and the 
Activation Q input box is disabled.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.

Figure 5-10. MS Detector Setup Page – Scan event settings with HCD experiment
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Chapter 6 Instrument Configuration

This chapter gives instructions on how to configure your instrument. It 
contains the following topics:

• “Starting Instrument Configuration” on page 6-2

• “FT Settings Page” on page 6-3

• “FT Mass Lists Page” on page 6-5
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Starting Instrument Configuration
From the Instrument Configuration dialog box, click on the 
LTQ Orbitrap Discovery MS button in the Configured Devices group 
box. See Figure 6-1. Then, click on the Configure button to open the 
LTQ Orbitrap Discovery Configuration dialog box.

The LTQ Orbitrap Discovery Configuration dialog box allows you to 
enter LTQ Orbitrap Discovery configuration information by using 
several pages, including the FT Settings page and the FT Manual 
Calibration page.

The elements of the pages are described in the following topics.

Figure 6-1. Instrument Configuration dialog box
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FT Settings Page
The FT Settings page of the LTQ Orbitrap Discovery Configuration 
dialog box allows you to edit the FTMS analyzer temperature setpoint 
and to enable the HCD specific features.1

Using the FT Settings page of the LTQ Orbitrap Discovery 
Configuration dialog box, you can select the following parameters:

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.

Figure 6-2. LTQ Orbitrap Discovery Configuration dialog box – FT Settings page

HCD option installed Select the check box if your instrument is 
equipped with the HCD option. Otherwise, 
HCD specific features are not available in 
the software. It is recommended to clear this 
check box only for diagnostic purposes.

Enable HCD collision gasSelect the check box to enable the 
HCD collision gas.1 Otherwise, using 
HCD fragmentation is not possible. It is 
recommended to clear this check box only 
for diagnostic purposes.

FTMS analyzer 
temperature setpoint (°C)

Enter the desired temperature for the 
Orbitrap analyzer chamber. The default 
value is 26.
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FT Settings Page
Note Configuration changes will become effective when you reboot 
your instrument. ▲
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FT Mass Lists Page
The FT Mass Lists page of the LTQ Orbitrap Discovery Configuration 
dialog box allows you to manipulate the mass lists that are displayed in 
the FT Manual page of the Calibrate dialog box. See Figure 6-3. You 
can also import or export a mass list as a text file.

Using the FT Mass Lists page of the LTQ Orbitrap Discovery 
Configuration dialog box, you can select the following parameters:

Figure 6-3. LTQ Orbitrap Discovery Configuration dialog box – FT Mass Lists page

Name This list box lists the names of the factory supplied 
and user created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions 
that you are using to calibrate the Orbitrap mass 
analyzer. You can select an existing mass list in the 
Name list box, or you can create or modify a mass 
list by clicking on and editing the entries in the 
Mass List table. 

Note Ensure that you use calibration masses of 
sufficient accuracy (sub ppm). ▲

Save Click on Save to save the mass list with the name 
that is selected in the Name list box.

Save As Click on Save As a to save the mass list with a new 
name.
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Delete Click on Delete to delete the mass list that is 
selected in the Name list box.

Import Click on Import to import a mass list that is a text 
file.

Export Click on Export to export a mass list to a text file.

Show Factory Lists Select this check box if you want to show the 
factory calibration mass lists in Tune Plus. 
6-6 LTQ Orbitrap Discovery Getting Started Thermo Fisher Scientific



Chapter 7 MALDI LTQ Orbitrap Series Instruments

This chapter describes only the Orbitrap relevant differences in 
instrument settings and procedures with respect to using a MALDI 
LTQ Orbitrap Series instrument. For further information, refer to the 
previous chapters of this manual, the MALDI Source Getting Started 
manual (P/N 97155-97012), and the MALDI Source Hardware Manual 
(P/N 97155-97013). 

This chapter contains the following topics:

• “Tune Plus Window” on page 7-2

• “MALDI Source Dialog Box” on page 7-4

• “Calibrating MALDI LTQ Orbitrap Series Instruments” on 
page 7-9

• “Diagnostics for MALDI” on page 7-17

• “Instrument Setup” on page 7-19

• “Instrument Configuration” on page 7-20

Note In this guide, the expression LTQ Orbitrap Series is used whenever 
an information is valid for the LTQ Orbitrap Discovery and the 
LTQ Orbitrap Discovery as well.

The screenshots in this chapter show the Tune Plus window for the 
MALDI LTQ Orbitrap XL. The information, however, is valid for all 
MALDI LTQ Orbitrap Series instruments. ▲
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Tune Plus Window
Tune Plus Window
Spectrum view, Graph view, and Status view show no differences to the 
standard instrument. They are described in Chapter 2: “Tune Plus 
Window”. 

Status View

The Tune Plus window shows a schematic view of the MALDI 
LTQ Orbitrap Series instrument. The content of the Status view - All 
page is extended by information about pressure in the upper and the 
lower chamber, and by laser information. See Figure 7-1.

Figure 7-1. Status View for MALDI LTQ Orbitrap Series instrument
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Scan Mode Menu
This section describes the elements of the Scan Mode menu that are 
different from the standard instrument.

Define Scan Dialog Box

As described in Chapter 2: “Tune Plus Window”, you can choose the 
analyzer type (ion trap or Orbitrap), mass resolution, and scan types. See 
Figure 7-2. You can as well define the scan range (First Mass–Last Mass 
window). Note that the Maximum Inject Time spin box in the Scan 
Time group box is disabled. For MALDI relevant aspects, refer to the 
MALDI Source Getting Started manual. 

Figure 7-2. Define Scan dialog box for MALDI
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Setup Menu
This section describes the elements of the Setup menu that are different 
from the standard instrument.

Injection Control Dialog Box - FT Page

On the FT page of the Injection Control dialog box, use the default 
MSn settings for FT detection as shown in Figure 7-3.

MALDI Source Dialog Box

The MALDI Source dialog box allows you to set up the MALDI source 
and to acquire data with it. 

❖ To open this dialog box

• From the Tune Plus window, choose Setup > MALDI Source, or 

• click on  in the Tune Plus toolbar.

Figure 7-3. FT injection control settings for MALDI
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Setup Menu
Control Page

The MALDI Source dialog box – Control page groups frequently used 
control parameters. This page allows you to control the motion of the 
sample plate (Plate Motion), to define the number of microscans/step, 
laser energy, acquisition settings, and to monitor the video image of the 
sample plate. See Figure 7-4.

Setup Page

The MALDI Source dialog box - Setup page allows you to define plate 
motion conditions and the laser energy – as on the Control page. See 
Figure 7-5 on page 7-6. Additionally, you can define different thresholds 
for automatic spectrum filtering (ASF) for linear trap analyzer and 
Orbitrap analyzer. Furthermore, you can define a number of sweep laser 
shots. They occur before the actual analytical laser scans and help to 

Figure 7-4. MALDI Source dialog box – Control page
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clean an impure sample surface at a new spot (from unwanted alkali 
ions, for example). The MS detector does not collect data during a 
sweep laser shot.

Acquire Page

The MALDI Source dialog box – Acquire page allows you to set up and 
acquire data with the MALDI source. See Figure 7-6. You can acquire 
data from multiple sample spots. For each sample spot, the data is saved 

Figure 7-5. MALDI Source dialog box - Plate Setup page
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Setup Menu
into a separate file. The plate position is automatically appended to the 
file name. Additionally, this page allows you to set the number of scans 
or the maximum time for acquisition.

Note The file information entered here for the sample plate is saved in 
memory until you remove the plate from the instrument. ▲

Figure 7-6. MALDI Source dialog box – Acquire page
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Setup Menu
Camera Page

The MALDI Source dialog box - Camera page allows you to view a large 
image from the camera. It can be helpful in finding a “sweet spot” in the 
sample spot and select it when Plate Motion is set to Manual (on the 
Control page or Setup page). 

Note Choosing about 100 microscans/spot in manual mode gives 
reasonable time to select samples manually. ▲
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Calibrating MALDI LTQ Orbitrap Series Instruments
This section describes the MALDI specific aspects of calibrating 
LTQ Orbitrap Series instruments.

ProteoMass MALDI Calibration Kit

Your system is delivered with the Sigma ProteoMass™ MALDI 
Calibration Kit. This kit can be reordered via Sigma-Aldrich (Product 
Code MS-CAL4). 
The so-called Standard Mix (ProteoMass Normal Mass Calibration Mix, 
Product Code C 9241) calibrates all LTQ devices in the mass range up 
to m/z 2000 and all Orbitrap devices. Mostly it is used to perform mass 
calibration in Orbitrap’s mass range m/z 50–2000.
The so-called High Mix (ProteoMass High Mass Calibration Mix, 
Product Code C 9366) calibrates various LTQ devices for high mass 
range high (m/z 100–4000) and Orbitrap’s mass range m/z 200–4000.

The MALDI Source Getting Started manual describes how to prepare the 
calibration and sensitivity test spots. Follow the protocol that is 
contained in the kit to get your system (linear trap and Orbitrap) 
calibrated according to the MALDI source specification. With respect to 
the Orbitrap analyzer, this means:

• Small Mass Range (m/z 50–800), 

• Universal Mass Range (m/z 150–2000), and 

• High Mass Range (m/z 200–4000).

Note At present, calibrating for Orbitrap’s High Mass Range overwrites 
a previously performed mass calibration for Orbitrap’s Universal Mass 
Range with the mass range up to m/z 4000. There is no unique mass 
calibration for Orbitrap’s mass range m/z 200–2000. ▲

For the above-listed mass ranges of MALDI LTQ Orbitrap Series 
instruments, there is a semi-automatic mass calibration for positive ion 
mode. It refers to the ions generated by the MALDI calibration 
solutions and it additionally uses ions of α-cyano-4-hydroxy cinnamic 
acid (HCCA matrix). See Table 7-1 on page 7-10 for the exact masses of 
the ions contained in the ProteoMass MALDI Calibration Kit. This 
calibration is carried out analogously to the mass calibration of the 
API source as described in Chapter 3: “Calibrating the Instrument for 
FTMS Measurements”. 
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The FT Manual calibration page allows performing a mass calibration 
with user-defined settings. See page 7-14. A semi-automatic calibration 
is also provided for Storage Transmission for masses below m/z 2000 
throughout all mass ranges. See page 7-11. FT Transmission calibration 
is performed in the factory.

Table 7-1. Exact masses of calibration compounds (ProteoMass™ MALDI Calibration Kit; Sigma-Aldrich MS-CAL4)

SEQUENCE PEPTIDE SUM FORMULA, MH+ MH+ MH+, av (M-H)- 

SYSMEHFRWGKPVGKK ACTH 1-16 C89 H134 N25 O22 S 1936.985048 1938.240577 1934.970490

GIGAVLKVLTTGLPALISWIKRKRQQ Mellitin C131 H230 N39 O31 2845.761447 2847.476759 2843.746890

DRVYIHPFHL Angiotensin C62 H90 N17 O14 1296.684767 1297.486046 1294.670210

FRWGKPVGKKRRPVKVYPNGAEDESAEAFPLE ACTH7_38 C167 H258 N47 O46 3657.928859 3660.130611 3655.914310

MRFA MRFA C23 H38 N7 O5 S 524.264964 524.658437 522.250410

RPPGFSPFR Bradikinin C50 H74 N15 O11 1060.568674 1061.218462 1058.554120

RPPGFSP Bradikini 1-7 C35 H53 N10 O9 757.39915 757.858143 755.384600

DRVYIHPFHLLVYS ReninSubstrate C85 H124 N21 O20 1758.932601 1760.026359 1756.918048

pyroEIYENKPRRPYIL Neurotensin C78 H122 N21 O20 1672.916951 1673.935326 1670.902398

DHB C7 H7 O4 155.03389 / 
154.02606 / 
137.02332

152.01151 /
153.01933

HCCA C10 H8 O3 N1 190.04987 144.045487

172.0393 188.035320

379.09246 333.088080
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Calibrating the Instrument for MALDI

This section describes how to calibrate MALDI LTQ Orbitrap Series 
instruments by using the various pages of the Calibrate dialog box.

Semi-Automatic Calibration for Small and Universal Mass Range

The Semi-Automatic page of the Calibrate dialog box (see Figure 7-7) 
allows you to select specific calibration parameters to calibrate, for 
example only the ion trap or only the FT. Via the Semi-Automatic page, 
positive ion mode calibration is achievable for storage transmission and 
mass calibration. For systems with an HCD collision cell, the 
Semi-Automatic page also provides positive ion mode calibration for 
HCD collision energy and HCD transmission. For negative mode 
calibration, refer to the topic ““FT Manual Calibration Page” on 
page 7-14“.

Note It is recommended to perform a semi-automatic mass calibration 
only once a week. ▲

The instrument displays real-time messages in the Status box about the 
procedure that is currently running. See the following example for a 
mass calibration check of the Normal mass range:

09:52:19:  Checking instrument calibration...
09:52:20:   Running
09:52:20:    External Mass Accuracy Check
09:52:20:     universal mass range / positive ions
09:52:20:      Reference masses m/z 172.039300 .. 1758.932601.

Figure 7-7. Semi-automatic calibration page, Normal Mass Range
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Calibrating MALDI LTQ Orbitrap Series Instruments
09:53:49:     Result: 0.957679 ppm RMS. Ok.
09:53:52:   Running
09:53:52:    External Mass Accuracy Check
09:53:52:     small mass range / positive ions
09:53:52:      Reference masses m/z 172.039300 .. 757.399150.
09:55:28:     Result: 0.624307 ppm RMS. Ok.
09:55:31:  FT Mass Calibration (pos) Check PASSED
09:55:31:  
09:55:31:  Calibration is OK!

Additionally, the instrument displays the progress of each mass 
calibration in the Graph View. See Figure 7-8 (mass calibration of the 
Small Mass Range) and Figure 7-9 on page 7-13 (mass calibration of the 
Universal Mass Range).

Figure 7-8. Mass calibration of the Small Mass Range
7-12 LTQ Orbitrap Discovery Getting Started Thermo Fisher Scientific



MALDI LTQ Orbitrap Series Instruments
Calibrating MALDI LTQ Orbitrap Series Instruments
Semi-Automatic Calibration for High Mass Range

For the High Mass Range, Tune Plus provides a semiautomatic 
calibration for the positive ion mode and the negative ion mode. See 
Figure 7-10.

Figure 7-9. Mass calibration of the Universal Mass Range

Figure 7-10. Semi-automatic calibration page, High Mass Range
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Automatic Calibration Page 

The Automatic page of the Calibrate dialog box (see Figure 3-4 on 
page 3-12) allows you to calibrate the instrument in positive ion mode.

Note Usually you should not perform a complete ion trap calibration or 
an FT ion calibration unless the hardware is modified in some way. 
However, it is necessary to repeat the electron multiplier calibration 
every one to three months and the FT mass calibration once a week. 
Thus, in the most cases it is not recommended to perform an automatic 
calibration of the MALDI LTQ Orbitrap Series instrument because all 
calibrations are performed, which takes about 1 hour. To run a 
multiplier gain calibration or an FT mass calibration (which takes only 
some minutes), it is recommended to use the semiautomatic 
calibration. ▲

Check Calibration Page

All calibration checks can be performed with the negative ion mode 
calibration solution or the mixtures contained in the ProteoMass 
MALDI Calibration Kit. Figure 7-11 shows the Graph View during a 
check of the mass calibration.

FT Manual Calibration Page

The FT Manual page of the Calibrate dialog box allows to perform or to 
check an FT mass calibration with user-defined calibration masses. See 
Figure 7-12 on page 7-15 and Figure 7-13 on page 7-16.

Figure 7-11. Checking the mass calibration (Normal Mass Range)
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Note Starting from the FT Manual Page, the calibration is performed 
for the currently selected polarity only. ▲

Because the FT Manual Calibration page allows using your own 
calibration masses, it is possible to use custom calibration solutions here. 
However, there are some requirements for the calibration masses. The 
scan ranges of the instrument need to be covered properly by the given 
masses.

Figure 7-12. Calibrate dialog box – FT Manual page: Normal Mass Range 
(NMR)
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Figure 7-13. Calibrate dialog box – FT Manual page: High Mass Range 
(HMR)
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Diagnostics for MALDI
In general, diagnostic procedures for the LTQ Orbitrap Series 
instrument are described in Chapter 4: “Performing 
Diagnostics/Checks”. This section only contains information relevant 
for instruments equipped with the MALDI source. For additional 
information, see also the MALDI Source Getting Started manual.

The MALDI page in the Diagnostics dialog box allows you to perform 
evaluation tests on the MALDI system, including the video camera and 
sample plate. See Figure 7-14.

When you adjust the brightness and contrast of the video camera, the 
values are saved automatically. See below. When you run any of the 
other tests, the results of the test are returned as pass or fail.

The Video Camera Contrast and Brightness page in the Diagnostics 
dialog box contains two sliding bars for adjusting the appearance of the 
CCD camera display. The Brightness and Contrast slider bars adjust the 
CCD camera image. The Reset button restores the factory default values 
for brightness and contrast. See Figure 7-15 on page 7-18.

Figure 7-14. MALDI page of the Diagnostics dialog box
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Figure 7-15. Video camera contrast and brightness test
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Instrument Setup
This section takes a look at the “Locking” feature in automated runs. 
See also page 5-3 of a description of the FT relevant topics of the data 
dependent settings in the Instrument Setup.

Using Locking in Automated Runs

In order to use locking in an automated run, use the Instrument Setup 
program. See Figure 7-16.

Note Refer to topic “Locking” on page 2-12 for a basic description on 
using locking with FTMS analyzer scans. ▲

The Lock Mass List button in the segment settings group brings up a 
lock mass list editor dialog. Segment-related lock masses can be entered 
here. There are separate lists for positive ion and negative ion mode. If 
the lock mass for a segment is empty, no locking will be applied in the 
run and the external calibration will be used.

Figure 7-16. Instrument Setup window for MALDI LTQ Orbitrap Series instrument
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Instrument Configuration
This section gives instructions on how to configure your MALDI 
LTQ Orbitrap Series instrument. It contains the following topics:

• “Starting Instrument Configuration” on page 7-20

• “Instrument Configuration Dialog Box” on page 7-21

• “MALDI Source Configuration Dialog Box” on page 7-22

Starting Instrument Configuration

❖ To configure your LTQ Orbitrap Series instrument

1. From the Instrument Configuration window, click on 
LTQ Orbitrap Discovery MS in the Configured Devices group 
box. See Figure 7-17. 

Figure 7-17. Instrument Configuration window
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2. Click on Configure to open the LTQ Orbitrap Series Instrument 
Configuration dialog box.

Instrument Configuration Dialog Box

This section describes the MALDI source relevant features of the 
LTQ Orbitrap Series Instrument Configuration dialog box.

Ion Source Page

The Ion Source page of the Configuration dialog box allows you to enter 
inlet configuration parameters for your LTQ Orbitrap Series 
instrument. Choose the MALDI item in the Default source list box. See 
Figure 7-18.

Display Page

The Display page of the Configuration dialog box allows you to 
configure the number of decimal places to show for certain values in 
Tune Plus and methods. See Figure 7-19 on page 7-22.

Figure 7-18. LTQ Orbitrap Series Configuration dialog box – Ion Source page
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MALDI Source Configuration Dialog Box

The MALDI Source Configuration dialog box displays the firmware 
version of the MALDI source and allows entering the serial number. See 
Figure 7-20.

Figure 7-19. LTQ Orbitrap Series Configuration dialog box – Display page

Figure 7-20. MALDI Source Configuration dialog box
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Appendix A Miscellaneous Information

This appendix contains supplemental information for the previous 
chapters. It contains the following topics:

• “FT Analyzer Information in Scan Header” on page A-2

• “Data Size of FT Raw Files” on page A-4
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FT Analyzer Information in Scan Header
The Qual Browser window allows you to open a raw file and to display 
scan header information for a selected scan in any of the cells. Choose 
View > Scan Header to display the Scan Header of the current scan in 
the active cell.

FT Analyzer Settings

The scan header information of an FTMS scan includes information 
about the FT Analyzer Settings that is not available in the usual Reports 
(Tune method, Instrument method, Status log, or Error log):

T=1e5 AGC Target for this scan (here: 1e+05)
PsIT=0.65 Prescan Inject Time (here: 0.65 ms)
Tog=(…) Manual diagnostic toggles are set different from 

their default values. See Table A-1 below for 
detailed information.

iWf Inject waveform on for this scan.
PvR=2e4 Preview analysis active for this scan 
DiagManualSettings Calibration parameters were manually changed 

under Diagnostics.

Table A-1. Actual settings of manual toggles

Tog = (…) Relevant Toggle Current setting Default setting

ApoOff FT apodization Off On

TrExp FT include transient On Off

FullP FT profile mode Full Reduced

IWFoff FT SIM and MSn injection 
waveforms 

Off On

Freq FT view frequency On Off 

Offset FT zero offset On Off
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FT Analyzer Messages

The scan header of an FT scan includes also so-called FT Analyzer 
Messages:

1RF=1535V RF amplitude value (here: 1535 V)
HCD=148eV HCD collision energy in eV (here: 

148 eV)1

Ufill=0.45 Maximum ion time reached. Here: the 
real number of ions is only ~45% of the 
target value.

MCal=4d Last mass calibration for this scan range 
is several days old (here: 4 days) 

Est=0x24 Machine-readable result message for 
post-processing tools

DAC=0.98 FT transient measurement near 
saturation, this might result in spectral 
harmonics (typically target value too 
high)

TCal=[195..] This is a hint that the current scan range 
settings for the FT analyzer are outside 
the calibrated storage/transfer mass 
range. Transfer parameters are 
extrapolated.

Lock=(inj524.3,1/1,+3ppm) Information about lock mass settings, 
extra SIM injection of lock mass ions, 
number of identified lock masses in the 
spectrum, and deviation of corrected 
(locked) masses compared to the external 
mass calibration.

Stable=15min Shows the elapsed stabilization time of 
the FTMS analyzer high voltage 
electronics after last off state or polarity 
switch. For best external mass accuracies, 
it is required to let the FTMS analyzer 
high voltage electronics stabilize before 
performing an acquisition or mass 
calibration.

1HCD is an option for LTQ Orbitrap Discovery. The feature will not be available if the 
instrument is not equipped with this option.
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Note The actual FT Analyzer Messages can also be displayed in the Tune 
Spectrum view, see topic “Spectrum View” on page 2-3. ▲

Data Size of FT Raw Files
The data size of a raw file with FT data depends on many parameters: 
for example, on the number of scans, the resolution setting, and the data 
format.

Table A-2 below displays typical data sizes (per scan) of an FT spectrum 
(negative mode calibration solution, scan range m/z 120–1200, 
AGC target 5E5, 1 microscan, resolution setting 30000) at different 
FT data formats.

TempDiff=1 There is a temperature difference in the 
FTMS analyzer temperature between 
mass calibration time and current state. 
This may be caused by setting a different 
analyzer temperature setpoint in 
instrument configuration, by rapid 
significant changes in the ambient 
temperature, or by not waiting for 
temperature stabilization after 
instrument (temperature regulation) was 
off.

PkOvf Internal Peak detection overflow in the 
FT spectrum analysis

Table A-2. Typical data sizes (per scan) of an FT spectrum

FT Data Format Typical data size / scan 

Centroid ca. 11 kB

Reduced Profile ca. 35 kB

Full Profile ca. 1430 kB
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Glossary
This section lists and defines terms used in this manual. It also includes acronyms, metric prefixes, symbols, and 
abbreviations.

A

A  ampere

ac  alternating current

ADC  analog-to-digital converter

adduct ion  An ion formed by the joining together of 
two species, usually an ion and a molecule, and often 
within the ion source, to form an ion containing all 
the constituent atoms of both species. 

AGC™  See Automatic Gain Control™ (AGC).

APCI  See atmospheric pressure chemical ionization 
(APCI).

APCI corona discharge current  The ion current 
carried by the charged particles in the APCI source. 
The voltage on the APCI corona discharge needle 
supplies the potential required to ionize the particles. 
The APCI corona discharge current is set; the APCI 
corona discharge voltage varies, as required, to 
maintain the set discharge current. 

See also corona discharge and APCI corona discharge 
voltage. 

APCI corona discharge voltage  The high voltage that 
is applied to the corona discharge needle in the APCI 
source to produce the APCI corona discharge. The 
corona discharge voltage varies, as required, to 
maintain the set APCI spray current. 

See also APCI spray current.

APCI manifold  The manifold that houses the APCI 
sample tube and nozzle, and contains the plumbing 
for the sheath and auxiliary gas. 

APCI needle, corona discharge  A needle to which a 
sufficiently high voltage (typically ±3 to ±5 kV) is 
applied to produce a chemical ionization plasma by 
the corona discharge mechanism. 

See also chemical ionization (CI), chemical ionization 
(CI) plasma, atmospheric pressure chemical ionization 
(APCI), and corona discharge.

APCI nozzle  The nozzle in the APCI probe that sprays 
the sample solution into a fine mist. 

See also atmospheric pressure chemical ionization 
(APCI).

APCI sample tube  A fused silica tube that delivers 
sample solution to the APCI nozzle. The APCI 
sample tube extends from the sample inlet to the 
APCI nozzle.

See also atmospheric pressure chemical ionization 
(APCI), and API stack. 

APCI source   Contains the APCI probe assembly, 
APCI manifold, and API stack.

See also atmospheric pressure chemical ionization 
(APCI), APCI manifold, and API stack.

APCI spray current  The ion current carried by the 
charged particles in the APCI source. The APCI 
corona discharge voltage varies, as required, to 
maintain the set spray current. 

APCI vaporizer  A heated tube that vaporizes the 
sample solution as the solution exits the sample tube 
and enters the atmospheric pressure region of the 
APCI source. 

See also atmospheric pressure chemical ionization 
(APCI).

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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API  See atmospheric pressure ionization (API).

API atmospheric pressure region  The first of two 
chambers in the API source. Also referred to as the 
spray chamber.

API capillary-skimmer region  The area between the 
capillary and the skimmer, which is surrounded by the 
tube lens. It is also the area of first-stage evacuation in 
the API source.

API heated capillary  A tube assembly that assists in 
desolvating ions that are produced by the ESI or APCI 
probe. 

See also API heated capillary voltage. 

API heated capillary voltage  The dc voltage applied to 
the heated capillary. The voltage is positive for positive 
ions and negative for negative ions. 

See also API source and API heated capillary.

API ion transfer capillary  A tube assembly that assists 
in desolvating ions that are produced by the ESI, NSI, 
or APCI probe. 

See also API ion transfer capillary offset voltage and 
API ion transfer capillary temperature.

API ion transfer capillary offset voltage  A dc voltage 
applied to the ion transfer capillary. The voltage is 
positive for positive ions and negative for negative 
ions. 

See also API source and API ion transfer capillary.

API ion transfer capillary temperature  The 
temperature of the ion transfer capillary, which should 
be adjusted for different flow rates.

See also API source and API ion transfer capillary.

API source  The sample interface between the LC and 
the mass spectrometer. It consists of the API probe 
(ESI or APCI) and API stack. 

See also atmospheric pressure ionization (API), ESI 
source, APCI source, ESI probe, and API stack. 

API spray chamber  The first of two chambers in the 
API source. In this chamber the sample liquid exits 
the probe and is sprayed into a fine mist (ESI or NSI) 
or is vaporized (APCI) as it is transported to the 
entrance end of the ion transfer capillary. 

API spray shield  A stainless steel, cylindrical vessel 
that, in combination with the ESI or APCI flange, 
forms the atmospheric pressure region of the API 
source. 

See also atmospheric pressure ionization (API).

API stack  Consists of the components of the API 
source that are held under vacuum and includes the 
API spray shield, API ion transfer capillary, API tube 
lens, skimmer, the ion transfer capillary mount, and 
the tube lens and skimmer mount. 

See also atmospheric pressure ionization (API) and 
API source. 

API tube lens  A lens in the API source that separates 
ions from neutral particles as they leave the ion 
transfer capillary. A potential applied to the tube lens 
focuses the ions toward the opening of the skimmer 
and helps to dissociate adduct ions. 

See also API tube lens offset voltage, API source, API 
ion transfer capillary, and adduct ion.

API tube lens and skimmer mount  A mount that 
attaches to the heated capillary mount. The tube lens 
and skimmer attach to the tube lens and skimmer 
mount. 

API tube lens offset voltage  A DC voltage applied to 
the tube lens. The value is normally tuned for a 
specific compound. 

See also API tube lens, adduct ion, and source CID. 

  APPI   See Atmospheric Pressure Photoionization 
(APPI).

ASCII  American Standard Code for Information 
Interchange

atmospheric pressure chemical ionization (APCI)  A 
soft ionization technique done in an ion source 
operating at atmospheric pressure. Electrons from a 
corona discharge initiate the process by ionizing the 
mobile phase vapor molecules. A reagent gas forms, 
which efficiently produces positive and negative ions 
of the analyte through a complex series of chemical 
reactions. 

See also electrospray ionization (ESI).
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atmospheric pressure ionization (API)  Ionization 
performed at atmospheric pressure by using 
atmospheric pressure chemical ionization (APCI), 
electrospray ionization (ESI), or nanospray ionization 
(NSI). 

Atmospheric Pressure Photoionization (APPI)  A soft 
ionization technique in which an ion is generated 
from a molecule when it interacts with a photon from 
a light source. 

  Automatic Gain Control™ (AGC)  Sets the ion 
injection time to maintain the optimum quantity of 
ions for each scan. With AGC on, the scan function 
consists of a prescan and an analytical scan.

auxiliary gas  The outer-coaxial gas (nitrogen) that 
assists the sheath (inner-coaxial) gas in dispersing 
and/or evaporating sample solution as the sample 
solution exits the APCI, ESI, or H-ESI nozzle.

auxiliary gas flow rate  The relative rate of flow of 
auxiliary gas (nitrogen) into the API source reported 
in arbitrary units.

auxiliary gas inlet  An inlet in the API probe where 
auxiliary gas is introduced into the probe.

See also auxiliary gas and atmospheric pressure 
ionization (API).

auxiliary gas plumbing  The gas plumbing that delivers 
outer coaxial nitrogen gas to the ESI or APCI nozzle.

auxiliary gas valve  A valve that controls the flow of 
auxiliary gas into the API source.

B

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per second

BTU  British thermal unit, a unit of energy

C

°C  degrees Celsius

CE  central electrode (of the Orbitrap)

cfm  cubic feet per minute

chemical ionization (CI)  The formation of new 
ionized species when gaseous molecules interact with 
ions. The process can involve transfer of an electron, 
proton, or other charged species between the 
reactants. 

chemical ionization (CI) plasma  The collection of 
ions, electrons, and neutral species formed in the ion 
source during chemical ionization. 

See also chemical ionization (CI).

CI  See chemical ionization (CI).

CID  See collision-induced dissociation (CID).

CLT  curved linear trap

cm  centimeter

cm3  cubic centimeter

collision gas   A neutral gas used to undergo collisions 
with ions.

collision-induced dissociation (CID)  An ion/neutral 
process in which an ion is dissociated as a result of 
interaction with a neutral target species. 

consecutive reaction monitoring (CRM) scan type  A 
scan type with three or more stages of mass analysis 
and in which a particular multi-step reaction path is 
monitored. 

Convectron™ gauge  A thermocouple bridge gauge that 
is sensitive to the pressure as well as the thermal 
conductivity of the gas used to measure pressures 
between X and Y.

corona discharge  In the APCI source, an electrical 
discharge in the region around the corona discharge 
needle that ionizes gas molecules to form a chemical 
ionization (CI) plasma, which contains CI reagent 
ions. 

See also chemical ionization (CI) plasma and 
atmospheric pressure chemical ionization (APCI).

CPU  central processing unit (of a computer)

CRM  See consecutive reaction monitoring (CRM) scan 
type.

C-Trap  curved linear trap

<Ctrl>  control key on the terminal keyboard
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D

d  depth

Da  dalton

DAC  digital-to-analog converter

damping gas  Helium gas introduced into the ion trap 
mass analyzer that slows the motion of ions entering 
the mass analyzer so that the ions can be trapped by 
the RF voltage fields in the mass analyzer. 

data-dependent scan  A scan mode that uses specified 
criteria to select one or more ions of interest on which 
to perform subsequent scans, such as MS/MS or 
ZoomScan. 

dc  direct current

divert/inject valve  A valve on the mass spectrometer 
that can be plumbed as a divert valve or as a loop 
injector. 

DS  data system

DSP  digital signal processor

E

ECD  See electron capture dissociation (ECD).

EI  electron ionization

electron capture dissociation (ECD)  A method of 
fragmenting gas phase ions for tandem mass 
spectrometric analysis. ECD involves the direct 
introduction of low energy electrons to trapped gas 
phase ions.

See also electron transfer dissociation (ETD) and 
infrared multiphoton dissociation (IRMPD).

electron multiplier  A device used for current 
amplification through the secondary emission of 
electrons. Electron multipliers can have a discrete 
dynode or a continuous dynode. 

electron transfer dissociation (ETD)  A method of 
fragmenting peptides and proteins. In electron 
transfer dissociation (ETD), singly charged reagent 
anions transfer an electron to multiply protonated 
peptides within the ion trap mass analyzer. This leads 

to a rich ladder of sequence ions derived from cleavage 
at the amide groups along the peptide backbone. 
Amino acid side chains and important modifications 
such as phosphorylation are left intact.

See also fluoranthene.

electrospray ionization (ESI)  A type of atmospheric 
pressure ionization that is currently the softest 
ionization technique available to transform ions in 
solution into ions in the gas phase. 

EMBL  European Molecular Biology Laboratory

<Enter>  Enter key on the terminal keyboard

ESD  electrostatic discharge

ESI  See electrospray ionization (ESI).

ESI flange  A flange that holds the ESI probe in 
position next to the entrance of the heated capillary, 
which is part of the API stack. The ESI flange also 
seals the atmospheric pressure region of the API 
source and, when it is in the engaged position against 
the spray shield, compresses the high-voltage 
safety-interlock switch. 

ESI probe  A probe that produces charged aerosol 
droplets that contain sample ions. The ESI probe is 
typically operated at liquid flows of 1 μL/min to 
1 mL/min without splitting. The ESI probe includes 
the ESI manifold, sample tube, nozzle, and needle. 

ESI source  Contains the ESI probe and the API stack. 

See also electrospray ionization (ESI), ESI probe, and 
API stack. 

ESI spray current  The flow of charged particles in the 
ESI source. The voltage on the ESI spray needle 
supplies the potential required to ionize the particles. 

ESI spray voltage  The high voltage that is applied to 
the spray needle in the ESI source to produce the ESI 
spray current. In ESI, the voltage is applied to the 
spray liquid as it emerges from the nozzle. 

See also ESI spray current.

ETD  See electron transfer dissociation (ETD).

eV  electron volt
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external lock mass  A lock that is analyzed in a separate 
MS experiment from your sample. If you need to run 
a large number of samples, or if accurate mass samples 
will be intermingled with standard samples, you might 
want to use external lock masses. These allow more 
rapid data acquisition by eliminating the need to scan 
lock masses during each scan.

F

f  femto (10-15)

°F  degrees Fahrenheit

.fasta file  extension of a SEQUEST® search database 
file

ft  foot

Fast Fourier Transform (FFT)  An algorithm that 
performs a Fourier transformation on data. A Fourier 
transform is the set of mathematical formulae by 
which a time function is converted into a 
frequency-domain function and the converse. 

FFT  See Fast Fourier Transform (FFT).

fluoranthene  A reagent anion that is used in an 
electron transfer dissociation (ETD) experiment.

firmware  Software routines stored in read-only 
memory. Startup routines and low-level input/output 
instructions are stored in firmware.

forepump  The pump that evacuates the foreline. A 
rotary-vane pump is a type of forepump.

Fourier Transform - Ion Cyclotron Resonance Mass 
Spectrometry (FT-ICR MS)  A technique that 

determines the mass-to-charge ratio of an ion by 
measuring its cyclotron frequency in a strong 
magnetic field. 

fragment ion  A charged dissociation product of an 
ionic fragmentation. Such an ion can dissociate 
further to form other charged molecular or atomic 
species of successively lower formula weights. 

fragmentation   The dissociation of a molecule or ion 
to form fragments, either ionic or neutral. When a 
molecule or ion interacts with a particle (electron, ion, 
or neutral species) the molecule or ion absorbs energy 
and can subsequently fall apart into a series of charged 
or neutral fragments. The mass spectrum of the 
fragment ions is unique for the molecule or ion. 

FT  Fourier Transformation

FT-ICR MS  See Fourier Transform - Ion Cyclotron 
Resonance Mass Spectrometry (FT-ICR MS).

FTMS  Fourier Transformation Mass Spectroscopy

full-scan type  Provides a full mass spectrum of each 
analyte or parent ion. With the full-scan type, the 
mass analyzer is scanned from the first mass to the last 
mass without interruption. Also known as single-stage 
full-scan type.

FWHM  Full Width at Half Maximum

G

g  gram

G  Gauss; giga (109)

GC  gas chromatograph; gas chromatography

GC/MS  gas chromatography / mass spectrometer

GUI  graphical user interface

H

h  hour

h  height

handshake  A signal that acknowledges that 
communication can take place.

HCD  Higher Energy Collision Induced Dissociation

header information  Data stored in each data file that 
summarizes the information contained in the file.

H-ESI source  Heated-electrospray ionization (H-ESI) 
converts ions in solution into ions in the gas phase by 
using electrospray ionization (ESI) in combination 
with heated auxiliary gas.
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high performance liquid chromatography (HPLC)  

Liquid chromatography in which the liquid is driven 
through the column at high pressure. Also known as 
high pressure liquid chromatography.

HPLC  See high performance liquid chromatography 
(HPLC).

HV  high voltage

Hz  hertz (cycles per second)

I

ICR  ion cyclotron resonance

ID  inside diameter

IEC  International Electrotechnical Commission

IEEE  Institute of Electrical and Electronics Engineers

in  inch

infrared multiphoton dissociation (IRMPD)  In 
infrared multiphoton dissociation (IRMPD), multiply 
charged ions consecutively absorb photons emitted by 
a infrared laser until the vibrational excitation is 
sufficient for their fragmentation. The fragments 
continue to pick up energy from the laser pulse and 
fall apart further to ions of lower mass.

See also electron capture dissociation (ECD).

  instrument method  A set of experiment parameters 
that define Xcalibur operating settings for the 
autosampler, liquid chromatograph (LC), mass 
spectrometer, divert valve, syringe pump, and so on. 
Instrument methods are saved as file type .meth.

internal lock mass  A lock that is analyzed during the 
same MS experiment as your sample and is contained 
within the sample solution or infused into the LC 
flow during the experiment. Internal lock masses 
provide the most accurate corrections to the data.

I/O  input/output

ion gauge  Measures the pressure in the mass analyzer 
region (high vacuum region) of the vacuum manifold. 

ion optics  Focuses and transmits ions from the API 
source to the mass analyzer.

ion source  A device that converts samples to gas-phase 
ions.

IRMPD  See infrared multiphoton dissociation 
(IRMPD).

K

k  kilo (103, 1000)

K  kilo (210, 1024)

KEGG  Kyoto Encyclopedia of Genes and Genomes

kg  kilogram

L

l  length

L  liter

LAN  local area network

lb  pound

LC  See liquid chromatography (LC).

LC/MS  See liquid chromatography / mass spectrometry 
(LC/MS).

LED  light-emitting diode

LHe  liquid helium

  liquid chromatography (LC)  A form of elution 
chromatography in which a sample partitions between 
a stationary phase of large surface area and a liquid 
mobile phase that percolates over the stationary phase. 

liquid chromatography / mass spectrometry 
(LC/MS)  An analytical technique in which a 

high-performance liquid chromatograph (LC) and a 
mass spectrometer (MS) are combined.

LN2  liquid nitrogen

lock mass  A known reference mass in the sample that is 
used to correct the mass spectral data in an accurate 
mass experiment and used to perform a real-time 
secondary mass calibration that corrects the masses of 
other peaks in a scan. Lock masses with well-defined, 
symmetrical peaks work best. You can choose to use 
internal lock mass or external lock mass.
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Glossary: log file
log file  A text file, with a .log file extension, that is used 
to store lists of information.

M

μ  micro (10-6)

m  meter; milli (10-3)

M  mega (106)

M+  molecular ion

MALDI  See matrix-assisted laser desorption/ionization 
(MALDI).

matrix-assisted laser desorption/ionization 
(MALDI)  Ionization by effect of illumination with a 

beam of laser generated light onto a matrix containing 
a small proportion of analyte. A mass spectrometric 
technique that is used for the analysis of large 
biomolecules.

MB  Megabyte (1048576 bytes)

MH+  protonated molecular ion

min  minute

mL  milliliter

mm  millimeter

MRFA  A peptide with the amino acid sequence 
methionine–arginine–phenylalanine–alanine.

MS  mass spectrometer; mass spectrometry

MS  MSn power: where n = 1

MS scan modes  Scan modes in which only one stage of 
mass analysis is performed. The scan types used with 
the MS scan modes are full-scan type and selected ion 
monitoring (SIM) scan type.

MSDS  Material Safety Data Sheet

MS/MS  Mass spectrometry/mass spectrometry, or 
tandem mass spectrometry is an analytical technique 
that involves two stages of mass analysis. In the first 
stage, ions formed in the ion source are analyzed by an 
initial analyzer. In the second stage, the mass-selected 
ions are fragmented and the resultant ionic fragments 
are mass analyzed.

MSn scan mode  The scan power equal to 1 to 10, 
where the scan power is the power n in the expression 
MSn. MSn is the most general expression for the scan 
mode, which can include the following:

• The scan mode corresponding to the one stage of 
mass analysis in a single-stage full-scan experiment 
or a selected ion monitoring (SIM) experiment 

• The scan mode corresponding to the two stages of 
mass analysis in a two-stage full-scan experiment or 
a selected reaction monitoring (SRM) experiment 

• The scan mode corresponding to the three to ten 
stages of mass analysis (n = 3 to n = 10) in a 
multi-stage full-scan experiment or a consecutive 
reaction monitoring (CRM) experiment.

See also MS scan modes and MS/MS. 

multipole  A symmetrical, parallel array of (usually) 
four, six, or eight cylindrical rods that acts as an ion 
transmission device. An RF voltage and dc offset 
voltage are applied to the rods to create an electrostatic 
field that efficiently transmits ions along the axis of 
the multipole rods.

m/z  Mass-to-charge ratio. An abbreviation used to 
denote the quantity formed by dividing the mass of an 
ion (in u) by the number of charges carried by the ion.
For example, for the ion C7H7

2+, m/z=45.5.

N

n  nano (10-9)

nanospray ionization (NSI)  A type of electrospray 
ionization (ESI) that accommodates very low flow 
rates of sample and solvent on the order of 1 to 
20 nL/min (for static nanospray) or 100 
to 1000 nL/min (for dynamic nanospray). 

NCBI  National Center for Biotechnology Information 
(USA)

NIST  National Institute of Standards and Technology 
(USA)

NMR  Normal Mass Range

NSI  See nanospray ionization (NSI).
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Glossary: octapole
octapole  An octagonal array of cylindrical rods that acts 
as an ion transmission device. An RF voltage and dc 
offset voltage applied to the rods create an electrostatic 
field that transmits the ions along the axis of the 
octapole rods.

O

OD  outside diameter

OT  Orbitrap

OVC  outer vacuum case

Ω  ohm

P

p  pico (10-12)

Pa  pascal

PCB  printed circuit board

PDA detector  Photodiode Array detector is a linear 
array of discrete photodiodes on an integrated circuit 
chip. It is placed at the image plane of a spectrometer 
to allow a range of wavelengths to be detected 
simultaneously.

PE  protective earth

PID  proportional / integral / differential

P/N  part number

p-p  peak-to-peak voltage

ppm  parts per million

PQD  pulsed-Q dissociation

psig  pounds per square inch, gauge

PTM  posttranslational modification

Q

quadrupole  A symmetrical, parallel array of four 
hyperbolic rods that acts as a mass analyzer or an ion 
transmission device. As a mass analyzer, one pair of 
opposing rods has an oscillating radio frequency (RF) 
voltage superimposed on a positive direct current (dc) 

voltage. The other pair has a negative dc voltage and 
an RF voltage that is 180 degrees out of phase with the 
first pair of rods. This creates an electrical field (the 
quadrupole field) that efficiently transmits ions of 
selected mass-to-charge ratios along the axis of the 
quadrupole rods.

R

RAM  random access memory

raw data  Uncorrected liquid chromatograph and mass 
spectrometer data obtained during an acquisition. 
Xcalibur and Xcalibur-based software store this data in 
a file that has a .raw file extension. 

resolution  The ability to distinguish between two 
points on the wavelength or mass axis.

retention time (RT)  The time after injection at which 
a compound elutes. The total time that the compound 
is retained on the chromatograph column. 

RF  radio frequency

RF lens  A multipole rod assembly that is operated with 
only radio frequency (RF) voltage on the rods. In this 
type of device, virtually all ions have stable trajectories 
and pass through the assembly. 

RF voltage  An ac voltage of constant frequency and 
variable amplitude that is applied to the ring electrode 
or endcaps of the mass analyzer or to the rods of a 
multipole. Because the frequency of this ac voltage is 
in the radio frequency (RF) range, it is referred to as 
RF voltage. 

RMS  root mean square

ROM  read-only memory

rotary-vane pump  A mechanical vacuum pump that 
establishes the vacuum necessary for the proper 
operation of the turbomolecular pump. (Also called a 
roughing pump or forepump.) 

RS-232  An accepted industry standard for serial 
communication connections. This Recommended 
Standard (RS) defines the specific lines and signal 
characteristics used by serial communications 
controllers to standardize the transmission of serial 
data between devices.
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Glossary: RT
RT  An abbreviated form of the phrase retention time 
(RT). This shortened form is used to save space when 
the retention time (in minutes) is displayed in a 
header, for example, RT: 0.00-3.75.

S

s  second

selected ion monitoring (SIM) scan type  A scan type 
in which the mass spectrometer acquires and records 
ion current at only one or a few selected 
mass-to-charge ratio values. 

See also selected reaction monitoring (SRM) scan 
type.

selected reaction monitoring (SRM) scan type  A scan 
type with two stages of mass analysis and in which a 
particular reaction or set of reactions, such as the 
fragmentation of an ion or the loss of a neutral moiety, 
is monitored. In SRM a limited number of product 
ions is monitored. 

SEM  secondary electron multiplier

Serial Peripheral Interface (SPI)  hardware and 
firmware communications protocol

serial port  An input/output location (channel) for 
serial data transmission.

sheath gas  The inner coaxial gas (nitrogen), which is 
used in the API source to help nebulize the sample 
solution into a fine mist as the sample solution exits 
the ESI or APCI nozzle. 

sheath gas flow rate  The rate of flow of sheath gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) that needs to be provided at 
the sheath gas inlet to provide the required flow of 
sheath gas to the ESI or APCI nozzle. 

sheath gas inlet  An inlet in the API probe where sheath 
gas is introduced into the probe. 

sheath gas plumbing  The gas plumbing that delivers 
sheath gas to the ESI or APCI nozzle. 

sheath gas pressure  The rate of flow of sheath gas 
(nitrogen) into the API source. A measurement of the 
relative flow rate (in arbitrary units) that needs to be 
provided at the sheath gas inlet to provide the required 
flow of inner coaxial nitrogen gas to the ESI or APCI 
nozzle. A software-controlled proportional valve 
regulates the flow rate. 

See also sheath gas. 

sheath gas valve  A valve that controls the flow of 
sheath gas into the API source. The sheath gas valve is 
controlled by the data system. 

  signal-to-noise ratio (S/N)  The ratio of the signal 
height (S) to the noise height (N). The signal height is 
the baseline corrected peak height. The noise height is 
the peak-to-peak height of the baseline noise. 

SIM  See selected ion monitoring (SIM) scan type.

skimmer  A vacuum baffle between the higher pressure 
capillary-skimmer region and the lower pressure 
region. The aperture of the skimmer is offset with 
respect to the bore of the ion transfer capillary. 

source CID  A technique for fragmenting ions in an 
atmospheric pressure ionization (API) source. 
Collisions occur between the ion and the background 
gas, which increase the internal energy of the ion and 
stimulate its dissociation. 

SPI  See Serial Peripheral Interface (SPI).

SRM  See selected reaction monitoring (SRM) scan 
type.

sweep gas  Nitrogen gas that flows out from behind the 
sweep cone in the API source. Sweep gas aids in 
solvent declustering and adduct reduction. 

See also sweep gas flow rate. 

sweep gas flow rate  The rate of flow of sweep gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) to provide the required flow of 
nitrogen gas to the sweep cone of the API source. 

See also sweep gas. 

  syringe pump  A device that delivers a solution from a 
syringe at a specified rate.
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Glossary: T
T

T  Tesla

target compound  A compound that you want to 
identify or quantitate or that a specific protocol (for 
example, an EPA method) requires that you look for. 
Target compounds are also called analytes, or target 
analytes. 

TIC  See total ion current (TIC).

TMP  See turbomolecular pump.

Torr  torr

total ion current (TIC)  The sum of the ion current 
intensities across the scan range in a mass spectrum. 

tube lens offset   The voltage offset from ground that is 
applied to the tube lens to focus ions toward the 
opening of the skimmer. 

See also source CID. 

Tune Method  A defined set of mass spectrometer tune 
parameters for the ion source and mass analyzer. Tune 
methods are defined by using the Tune Plus (LCQ 
Series, LXQ, and LTQ) or Tune Master (TSQ 
Quantum) window and saved as the file type 
.LCQTune, .LTQTune, or.TSQTune, respectively.

A tune method stores tune parameters only. 
(Calibration parameters are stored separately, not with 
the tune method.)

tune parameters  Instrument parameters whose values 
vary with the type of experiment. 

turbomolecular pump  A vacuum pump that provides 
a high vacuum for the mass spectrometer and detector 
system. 

TWA  time weighted average

U

u  atomic mass unit

UHV  ultra high vacuum

Ultramark 1621  A mixture of 
perfluoroalkoxycyclotriphosphazenes used for ion trap 
calibration and tuning. It provides ESI singly charged 
peaks at m/z 1022.0, 1122.0, 1222.0, 1322.0, 1422.0, 
1522.0, 1622.0, 1722.0, 1822.0, and 1921.9. 

UMR  Universal Mass Range

V

V  volt

V ac  volts alternating current

V dc  volts direct current

vacuum manifold  A thick-walled, aluminum chamber 
with machined flanges on the front and sides and 
various electrical feedthroughs and gas inlets that 
encloses the API stack, ion optics, mass analyzer, and 
ion detection system. 

vacuum system  Components associated with lowering 
the pressure within the mass spectrometer. A vacuum 
system includes the vacuum manifold, pumps, 
pressure gauges, and associated electronics.

vent valve  A valve that allows the vacuum manifold to 
be vented to air or other gases. A solenoid-operated 
valve. 

vol  volume

W

w  width

W  watt
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Index

A
absolute collision energy 2-13
accuracy, of calibration masses 3-22, 6-5
Activation page 5-11
Activation Q 2-13, 5-11, 5-13
activation type 2-13, 5-13
actual settings, of manual toggles A-2
α-cyano-4-hydroxy cinnamic acid 7-9
Advanced Calibration features 2-8, 3-17
Advanced Features, in instrument setup 5-7
Advanced Scan features 2-9
AGC 2-11

stability 4-5
AGC target A-2

compensation factor 4-3
values 2-11, 2-18, 2-22

All page, of the Status view 2-5
analyzer

temperature control 4-7
type 2-10
vacuum 4-7

analyzer information, for FTMS scans 2-4
analyzer type 2-10
API accessory kit 3-5, 3-7
apodization 4-7
ASF 7-5
automated run 5-2, 7-19
automatic calibration 3-2, 3-12
automatic gain control (AGC) 2-18
Automatic page, of the Calibrate dialog box 3-12
automatic spectrum filtering 7-5
automatic tune, recommended settings 3-10

B
bakeout procedure 2-21
Br, in molecules 5-7
brightness and contrast, of the video camera 7-17

C
Calibrate dialog box 3-14, 7-11

automatic calibration 3-12
check calibration 3-18
Check page 3-18
FT manual calibration 7-14
FT Manual page 3-21, 7-15–7-16

Semi-Automatic page 3-14, 3-16–3-17
calibrating

FT Measurements 3-1
HCD collision energy 3-16
HCD transmission 3-16

calibration
automatic 3-12
automatic check settings 3-18
FT manual calibration 3-21, 7-14
ion trap 3-9
negative ion mode 3-19
parameters 3-2, 4-12, A-2
positive ion mode 3-19
procedures 3-2
semi-automatic calibration 3-14, 7-11
values 3-3

calibration checks 3-18, 7-14
readback 3-20

calibration files
backups 3-3
content 4-3
history 3-3

calibration masses 3-8, 7-15
accuracy 3-22, 6-5

calibration solutions 3-4
FT manual calibration 3-8
negative mode 3-7–3-8, 3-10, 3-22
ordering 3-4

calmix 3-22
camera 7-8
centroid format 2-15
changing instrument settings 4-11
Charge State page 5-7
charge states 2-13–2-14, 5-3, 5-5, 5-7

peaks 2-4
recognition 5-6

Check page 3-18
checks

calibration 3-18
mass duration 4-11

chemicals, ordering 3-5
CID 2-13
Cl, in molecules 5-7
cleaning, impure sample surfaces 7-6
collision energy 3-20
collision gas, for HCD 4-7
compensation factor 4-3
complex isotopic pattern 5-7
compressed profile format 2-15
configuration changes 6-4
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Index: D
Control menu 2-8
converting, masses to mass-to charge ratios 5-3
Current Scan Event page 5-8–5-9
Current Segment page 5-6
custom calibration solutions 7-15

D
data dependent FT SIM scan 5-8
data dependent settings

charge state 5-7
current segment 5-3, 5-6

data formats
storage 2-23
switching formats 2-15

data sizes, of FT mass spectrum A-4
define scan

analyzer type 2-10
inject time 2-11
locking feature 2-12
mass range 2-10
recommended settings for automatic ion trap tuning 3-10
resolution 2-10
scan rate 2-10
scan time 2-10
scan type 2-10

Define Scan dialog box 2-9, 3-10
diagnostic toggles A-2
diagnostic views 2-4
Diagnostics dialog box, Toggles page 4-6
Display menu 2-16
Display page, of the Configuration dialog box 7-21
Display Settings page 4-12
displaying, instrument settings 4-12
duration, of FT Manual mass calibration checks 4-11
Dynamic Exclusion 5-7
dynamic exclusion mass widths 5-4
dynamic range 2-19
dynamics of ions, in HCD collision cell 4-3

E
editing, lock mass lists 2-12, 2-21
electron multiplier

calibration 3-13
gain 3-9
gain calibration 3-9

electron multiplier calibration 7-14
enabling

HCD collision gas 6-3
injection waveforms 2-19

ESI parameters 2-23
exclusion mass widths 5-4
external calibration 2-12, 5-2, 7-19

external mass accuracy 4-5

F
factory-supplied mass lists 3-22, 6-6
firmware version, of MALDI source 7-22
fragment ion spectra 2-13
frequency spectrum 4-9
FT analyzer 4-3

automatic calibration 3-15
information in scan header A-2
ion gauge 4-7
messages A-3
settings A-2
target values 2-19
temperature control 4-7

FT apodization 4-7
FT calibration 3-14

procedures 3-12
FT diagnostics, displaying 4-12
FT dynamic range test 4-2
FT HCD page 5-12
FT injection waveforms 2-20
FT instrument calibration 4-11
FT instrument settings 4-13
FT isolation test 4-3
FT Lockmass Abundance 4-11
FT manual mass calibration checks 4-11
FT Manual page 3-2, 3-8, 3-21, 7-10, 7-15–7-16
FT mass calibration 3-2, 3-13, 3-20–3-21, 4-3, 7-14

automatic calibration 3-15
FT Mass Lists page 6-5
FT mass spectrum, resolution 2-10
FT MSn scans, injection waveforms 4-8
FT noise test 4-3
FT optics values 4-11
FT page, of the Injection Control dialog box 7-4
FT Preamp Evaluation page 4-3
FT profile mode 4-8
FT readback values 2-17
FT sensitivity test 4-4
FT Settings page 6-3, 6-5, 7-21–7-22
FT SIM scans 5-8

injection waveforms 4-8
scan width 5-10

FT spectrum, label of x-coordinate 4-9
FT stability test 4-4–4-5
FT storage multipole RF 4-9
FT storage transmission calibration 3-19
FT target values 2-19
FT Temperature Control Evaluation 4-5
FT Temperature Monitor 4-5

dialog box 2-21
icon 2-21
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Index: G
FT TIC, stability 4-4
FT transfer multipole

frequency calibration 2-5
RF 4-9

FT Transfer Optics dialog box 2-17
FT transfer parameters 2-17
FT transmission 2-8, 3-17

calibration 2-17, 3-2, 3-20–3-21, 7-10
FT vacuum 2-20
FT view frequency 4-9
FT zero offset 4-9
FTMS analyzer

signal detection path 4-3
temperature A-4
temperature regulation 2-21

Full MS target 2-19
full noise band 4-9
Full Profile format 4-8–4-9

G
glacial acetic acid 3-6, 3-8
Global page 5-3
Graph view 2-5

H
HCCA matrix 7-9
HCD 2-13, 5-11

charge state 2-14, 5-13
collision cell 2-2
collision energy 3-16, 3-20, A-3
collision energy calibration 7-11
collision gas 4-7
collision gas, enabling 6-3
dynamics of ions 4-3
enabling, collision gas 6-3
instrument icon 2-2
scan ranges 2-14
transmission 3-16, 3-20
transmission calibration 3-16, 7-11

high charge states 5-6
high mass accuracy measurements 4-5
High Mass Range

calibration 7-9
semiautomatic calibration 7-13

high mass range mode 4-3
high voltage pulser, testing 4-4

I
infusion experiment 4-2–4-4
inject time 2-11, 3-11

injection control
FT target values 2-19
ion trap target values 2-18

Injection Control dialog box 2-18, 4-8
injection waveforms 2-19–2-20, 4-8, A-2

enabling/disabling 2-18–2-19
flags 2-23

in-source fragmentation 3-11
Instrument Configuration dialog box 6-2, 7-20

Display page 7-22
FT Settings page 7-21–7-22

Instrument Control toolbar 2-2, 2-17–2-18, 2-20
instrument method 2-23
instrument reset 4-11
instrument settings, displaying 4-12
Instrument Setup 5-1–5-3, 7-19
intensity, of peaks 5-7
internal peak detection overflow A-4
internal reference 2-12
ion energy 4-2
ion mode 2-15
ion polarity

changing 2-15
mode 2-22

Ion Source page, of the Configuration dialog box 7-21
ion trap

automatic calibration 3-15
calibration 3-9
checking, calibration parameters 3-19
spectrum, of negative mode calibration solution 3-10–3-11
target values 2-18
tuning, recommended settings 3-10

isolation/fragmentation efficiency 2-19
isotope exclusion 5-4
isotopic cluster recognition 5-7

L
laser

energy 7-5
information 7-2

last successful check 3-20
lock mass abundance 2-12, 4-11
Lock Mass List button 5-2, 7-19
lock masses 2-12, 5-2

lists 2-12, 2-21
settings A-3

Lock Masses dialog box 2-12, 2-21, 5-2
locking

enabling 2-12
in automated runs 5-2, 7-19

LTQ Orbitrap Discovery Configuration dialog box 6-2
FT Mass Lists page 6-5
FT Settings page 6-3, 6-5
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Index: M
M
MALDI

firmware version, of source 7-22
serial number, of source 7-22
source specification 7-9

MALDI page, in the Diagnostics dialog box 7-17
MALDI Source Configuration dialog box 7-22
MALDI Source dialog box 7-4

Acquire page 7-6
Camera page 7-8
Control page 7-5
Setup page 7-5

mass accuracy 2-19, 4-5
mass calibration 4-2, 7-11
mass deltas 5-4
mass differences 5-4
mass lists 3-22, 6-5
mass range 5-4

coverage 4-8
selecting 2-10

mass resolution 2-10
mass-to-charge ratio, as mass 5-3
mass-to-charge ratios 3-22
maximum AGC target value 4-3
maximum inject time 2-11, 2-22, 7-3
microscans 2-10, 2-22
monoisotopic peaks 5-8
monoisotopic precursor selection 5-7–5-8
MRFA

alone solution 4-2–4-3
signal 4-2

MS Charge State 5-5
MS Detector Setup page 5-2
MSn injection waveforms 4-8
MSn settings 2-13
MSn target 2-19
multiplier gain calibration 3-13

N
negative ion mode 3-11, 3-14–3-15

checking calibration 3-19
negative mode calibration solution 3-7–3-8, 3-10, 3-22

preparing 3-7
neutral loss mass widths 5-4
non-peptide monoisotopic peak recognition 5-8

O
Orbitrap

chamber temperature 6-3
selecting as analyzer 2-10

ordering
calibration solutions 3-4
chemicals 3-5

overriding, calibration values 4-11

P
parameters, of vacuum system 2-20
parent mass list 5-5
parent mass widths 5-4
peak intensity 5-7
peak labels 2-4
peaks, charge state 2-4
performing diagnostics/checks 4-1
plate motion 7-5
plate position 7-7
positive ion mode 3-14

checking calibration 3-19
positive mode calibration solution 4-3

preparing 3-6
PQD 2-13
preamplifier

evaluation 4-3
input protection switches 4-4

Prescan Inject Time A-2
pressure, in the upper and the lower chamber 7-2
preview analysis A-2
preview mode 5-6
product mass list 5-5
product mass widths 5-4
profile format 2-15
ProteoMass MALDI Calibration Kit 7-9

Q
Q value 2-13

R
readback values 4-12
Reduced Profile format 4-8–4-9
rejecting

mass list 5-5
mass widths 5-4

repeating, previous scan event with HCD 5-9
reserpine 4-4
resistant noise peaks 4-3
resolution 5-6

FT mass spectrum 2-10
RF amplitude A-3
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Index: S
S
sample plate 7-7
scan description 2-10
scan header 4-6, 4-8, A-2
Scan Mode menu 2-9
scan range settings A-3
scan ranges, in HCD experiment 2-14
scan rate 2-10
scan time 2-10
Scan Time Settings dialog box 2-11
scan type 2-10
Scan widths page 5-10
selecting

analyzer type 2-9
calibration masses 3-2
devices 4-10
experimental parameters 4-10

semi-automatic calibration 3-2, 3-14, 7-11
semi-automatic mass calibration, frequency 7-11
Semi-Automatic page, of the Calibrate dialog box 2-8, 3-14, 
3-16
serial number, of MALDI source 7-22
Set device page 4-10, 4-13
settings, of manual toggles A-2
Setup menu 2-17
shortcut menu, in Spectrum view 2-3
signal-to-noise ratio 4-2
SIM target 2-19
Small Mass Range 7-9
Sn, in molecules 5-7
sodium dodecyl sulfate 3-7
sodium taurocholate 3-7
spectrum averaging 2-16
Spectrum Display Options dialog box 2-4
Spectrum view

display options 2-3
shortcut menu 2-3, 4-7

starting, instrument configuration 6-2, 7-20
Status view 2-5
stock solutions

MRFA 3-5, 3-7
sodium dodecyl sulfate 3-7
sodium taurocholate 3-7
Ultramark 1621 3-6

storage multipole 3-19
storage transmission 2-8, 3-17

calibration 3-19, 3-21, 7-11
sweep laser shots 7-5
sweet spots 7-8
switching, data formats 2-15
syringe pump 4-11
System Evaluation page 4-2, 7-17
system performance 4-2

T
target values 4-11

FT analyzer 2-19
ion trap 2-18

temperature
monitor 4-5
of Orbitrap chamber 6-3
setpoint 2-21

temperature regulation 2-21
behavior 4-5
evaluation 4-5
results 4-5

testing, HV pulser 4-4
tin, in molecules 5-7
Toggles page 4-6
total ion current 4-4
transfer multipole 3-19
transient view 4-7
transients 2-10, 4-7

averaging 2-16
transmission 3-20
tube lens, manual adjustment 3-9, 3-11
tune methods 2-22
Tune Plus window 2-1–2-2, 3-3, 7-2

Display menu 2-16
Scan Mode menu 2-9
Setup menu 2-17
version 1-1
View menu 2-3

tuning
ion trap for negative ion mode 3-11
ion trap for positive ion mode 3-9

U
Ultramark 1621 3-7
Universal Mass Range 7-9
User page, of the Status view 2-5
User Status Display Configuration dialog box 2-5, 2-7

V
vacuum

icon 2-20
system parameters 2-20

Vacuum dialog box 2-20
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